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Trademarks 

Microsoft is a U.S. registered trademark of Microsoft Corporation. 

Windows, Windows Vista, Windows 7, Windows 8, and Windows 10 
are either registered trademarks or trademarks of Microsoft 
Corporation in the United States and/or other countries. 

Energy Star® is a registered trademark of the U.S. government. 

IBM, IBM PC are registered trademarks of International Business 
Machines Corp. 

Other brands and product names herein are trademarks or 
registered trademarks of their respective holders. 

Copyright 

All rights reserved. No part of this publication may be 
reproduced, transmitted, transcribed, stored in a retrieval 
system, or translated into any language or computer language, 
in any form or by any means, electronic, mechanical, magnetic, 
optical, chemical, manual, or otherwise, without the prior written 
permission of Avision Inc. 
 
Material scanned by this product may be protected by 
governmental laws and other regulations, such as copyright 
laws, the customer is solely responsible for complying with all 
such laws and regulations. 

 

Warranty 

The information contained in this document is subject to 
change without notice. 
 
Avision makes no warranty of any kind with regard to this 
material, including, but not limited to, the implied warranties 
of fitness for a particular purpose. 
 
Avision shall not be liable for errors contained herein or for 
incidental or consequential damages in connection with the 
furnishing, performance, or use of this material.  
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FCC Radio Frequency Interference Statement  

This product has been tested and found to comply with the 
limits for a class B digital device, pursuant to Part 15 of the 
FCC rules. Operation is subject to the following two 
conditions: (1) this device may not cause harmful 
interference, and (2) this device must accept any 
interference received, including interference that may cause 
undesired operation.   The FCC Class B limits are designed 
to provide reasonable protection against harmful 
interference in a residential installation. This equipment 
generates, uses, and can radiate radio frequency energy 
and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that 
interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or 
television reception, which can be determined by turning 
the equipment off and on, the user is encouraged to try to 
correct the interference by one or more of the following 
measures: 

 Reorient or relocate the receiving antenna. 
 Increase the separation between the equipment and 

receiver. 
 Connect the equipment into an outlet on a circuit different 

from that to which the receiver is connected. 
 Consult your point of purchase or service representative 

for additional suggestions. 
  
 
 
         



User’s Manual 

 iv 

 
 

 
European Union Regulatory Notice 
 
Products bearing the CE marking comply with the following EU 
Directives: 
 
 Low Voltage Directive 2014/35/EC 
 EMC Directive 2014/30/EC 
 Restriction of the use of certain hazardous substances 

(RoHS) Directive 2014/53/EU 
 RED (Radio Equipment Directive) (2014/53/EC) 
 

CE compliance of this product is valid if powered with the correct 
CE-marked AC adapter provide by Avision. 

This product satisfies the Class B limits of EN55022, EN55024, 
safety requirements of EN 60950 and ROHS requirements of 
EN50581. 
 

*This machine is certified as Class 1 LED product.  

 

 

 

As an ENERGY STAR® Partner, Avision Inc. has 
determined that this product meets the ENERGY 
STAR guidelines for energy efficiency. 
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Disposal of Waste Equipment  

 

This symbol on the product or on its packaging indicates that the 
product can not be disposed of with your other household waste.  
Instead it should be sent to appropriate facilities for recovery 
and recycling in an effort to protect human health and the 
environment.  Fore more information about where you can drop 
off your waste equipment for recycling, please contact your local 
city office, your household waste disposal service or the shop 
where you purchased the product.   
 

System Requirements 

 
CPU: Intel® Core™ 2 Duo or higher 

Memory: 32 bit: 2GB 

64 bit: 4GB 

Optical Drive: DVD-ROM Drive 

USB Port: USB port 2.0 (compatible with USB 3.0) 

Compatible 
Operating 

System: 

Microsoft Windows 10 (32 bits/64 bits), 
Windows 8 (32 bits/64 bits), Windows 7, 
Windows XP(SP3), Windows Vista 
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Product Safety Guide 

Please clearly read all these instructions, and follow all instructions 
and warnings before installing and using the device.  
 
The following indications are used in this document to obviate any 
chance of accident or damage to you and/or the device. 
 

 WARNING Indicates potentially hazardous situations, which 
if instructions are not followed, could result in 
death or serious injury. 

 CAUTION Indicates a potentially hazardous situation 
which, if instructions are not followed, may 
result in minor or moderate injury or damage to 
property. 

 
 WARNING 

 Use only the AC power adapter that came with your device. 
Using any other AC power adapter could cause fire, electrical 
shock, or injury. 

 Use only the AC power cord and USB cable that came with your 
device and avoid abrasions, cuts, fraying, crimping, and kinking. 
Using any other AC power cord and USB cable could cause fire, 
electrical shock, or injury. 

 Do not place objects on top of the AC power cord, and do not 
allow the AC power adapter or the AC power cord to be stepped 
on or run over. 

 Place the device and its AC power adapter near an electrical 
outlet where the AC power adapter can easily be unplugged. 

 If you use an extension cord with the device, make sure that 
the total ampere rating of the devices plugged into the 
extension cord does not exceed the cord's ampere rating. 

 Place the device close enough to the computer so that the 
interface cable can easily reach between the device and the 
computer. 
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 Do not place or store the device or its AC power adapter: 
 Outdoors 
 Near excessive dirt or dust, water, or heat sources 
 In locations subject to shocks, vibrations, high 

temperature or humidity, direct sunlight, strong light 
sources, or rapid changes in temperature or humidity 

 Do not use the device with wet hands. 

 Never disassemble, Modify, or attempt to repair the AC power 
adapter, device, or device option by yourself, except as 
specifically explained in the device's documentation. This could 
cause fire, electrical shock, or injury. 

 Do not insert objects into any opening, as they may touch 
dangerous voltage points or short-out components. Beware of 
electrical shock hazards. 

 Unplug the device and the AC power adapter, and refer 
servicing to qualified service personnel under the following 
conditions: 

 The AC power adapter or plug is damaged. 
 Liquid has entered the device or the AC power adapter. 
 Object has entered the device or the AC power adapter. 
 The device or the AC power adapter has been dropped, 

or the case has been damaged. 
 The device or the AC power adapter does not operate 

normally (i.e. appearance of smoke, strange smell, odd 
noise, etc.), or exhibits a distinct change in performance  

 Unplug the device and the AC power adapter before cleaning. 
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 CAUTION: 

 Do not locate the device on rackety or aslope tables. Do not 
locate the device on unstable surface. The device may fall 
down and this may result in injury. 

 Do not place heavy objects on the unit. It may cause 
unbalance and the device may fall down. This may result in 
injury. 

 Store the AC Power cord/USB cable bundled out of the reach of 
children to avoid the risk of injury. 

 Keep plastic bags bundled out of the reach of children or throw 
them away to avoid the danger of suffocation. 

 If you are not going to use the device for a long period, unplug 
the AC power adapter from the electrical outlet. 
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1. Introduction 
 
 
Thank you for purchasing the network scanner. Without any 
computer, the product allows you to scan single-sided or 
double-sided document(s) and deliver the electronic images 
to various destinations including E-mail addresses, ftp 
servers, network folders, or a USB drive.  

What is best, with the built-in Wi-Fi module, the Avision 
network scanner allows your mobile devices (smartphone, 
tablet, etc.), wireless or wired computers in the LAN to start a 
scan and receive the scanned image. 

Before you install and operate the new scanner, please take a 
few minutes to read through this manual.  It provides proper 
instructions for you to unpack, install, operate and maintain 
the scanner. 

 

1.1 Features 

Scan-to-E-mail: 
Connected to an ethernet network and a SMTP server, the 
product allows you to transmit document(s) to your E-mail as an 
attachment.  With a specified E-mail profile, the document(s) 
is/are first scanned and converted into an image file, and then 
transmitted to remote recipients within minutes.   

 
Scan-to-Network:   
The product allows you to send the scanned documents to a 
network via FTP (File Transfer Protocol) or CIFS (Common 
Internet File System) protocol.  The scan-to-folder feature off-
loads the mail server from handling large attachments. 
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Managing the Product Remotely: 
The product provides a convenient way to manage your E-mail 
address book, filing destinations (network folders) remotely.  By 
simply typing the machine's IP address in the URL field of your 
browser, the product web page will be prompted. This web page 
allows the administrator to create up to 20 E-mail profiles and 
20 filing destinations to conveniently deliver the scanned 
documents to multiple recipients.  

 
Scanning and Saving Your Images to a USB Flash Drive: 
By plugging a USB flash drive into the USB port of the product, 
the product allows you to scan your document and save the 
scanned images to your USB flash drive. 
 
 

1.2 Package Items 

The following figure indicates the package contents.  Please 
check all the items against your checklist.  If you do not 
receive all the items, please contact your authorized local 
dealer immediately. 
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1. Scanner Main Unit 
2. Quick Guide/CD 
3. USB Cable 
4. Power Adapter & Power Cord 
 

Note:  
1. Only use the AC adapter DA-48M24 by APD included in the 

machine.  Using other AC adapters may damage the machine 
and void the warranty. 

2. Please unpack the packing carefully, and check the contents 
against the checklist.  If any items are missing or damaged, 
please contact your dealer immediately. 

3. To access more service supports, visit www.avision.com to 
register your Avision’s product.  

  
 
 

2 

4 

1 

3 

http://www.avision.com./�
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1.3 Front View 

 

 
Part Name Function 

Extension Can be pulled out and adjusted to the 
size of the document being scanned. 

ADF Paper Tray Load the document onto this part 
when scanning document. 

Paper Guides Adjusts to the width of the documents 
to prevent skewing of the scanned 
pages. 

Operation Panel LCD screen: 
Shows menu options and scan 
progress.   
The Power Button: 
Press to turn on the power. 
The Scan Button: 
Press to start a scan (BM2 Air). 
The Cancel Button: 
Press to cancel a scanning job during 
operation. 

 Extension

Paper Guide 

Paper Stopper 

Power Button 

Paper Guide 

Output Tray 

Extension 

ADF  
Paper Tray 

LCD Screen with 
Up/Down Buttons 

Scan Button 

Stop Button 
Paperweight 

Position Adjuster 
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Output Tray Open to collect the document after 
scanned. 

Position 
Adjuster 

Slide the adjuster inward to make the 
Output Tray in a flat position. 

Extension Pull it out. Documents are ejected 
from the ADF to the tray. 

Paperweight Used to hold down a stack of output 
paper. 

Paper Stopper Adjust to the length of the documents 
to prevent them from falling apart. 

 
 

1.4 Operational Panel 

 
 

LCD 
screen 

Used to display information and provide access 
to the product’s functions. 

Wi-Fi LED Used to indicate the Wi-Fi status. 

Stop Used to stop an operation. 

Scan Used to start a scan. 

 /  Used to toggle through the menus or options.  

Enter   Used to enter a selection. 

Back  Used to go back to the previous level.  

  Used to show to basic system information. 
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1.5 Rear View 

 

 
 
 
 

 
Part Name Function 

Power Jack Connect the AC adapter to the 
scanner. 

LAN port Connect the LAN cable to the 
scanner for wired network 
connection. 

USB Port Connect the USB cable to the 
scanner.  

Kensington 
Security Slot 

Attach to a lock to secure the 
scanner. 

 
 
 

Power 
Jack 
LAN Port 

WPS Button 

USB Port 

Kensington 
Security 

Slot 

Wi-Fi Switch 
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1.6 Side View 

 
 
 

Part Name Function 

USB Flash Drive Used to insert a USB flash drive. 

USB Flash 
Port 
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1.7 Pre-installation Checklist 

The product has to be setup properly on your network to 
perform scan to E-mail and scan to network functions.  Before 
using the product, please setup the product properly on your 
network for E-mail and filing function. The following network 
parameters have to be set. 
 

1.  DHCP Enable:  
2.  IP Address:      .    .    . 
3.  Subnet Mask:     .    .    . 
4.  Gateway IP:     .    .    . 
5.  DNS Server: .    .    . 
6.  WINS Server: .    .    . 
7.  SMTP Server:     
8.  SMTP Port:  25 
9.  LDAP Server:     .    .    . 
10. LDAP Port:  

Explanation of contents: 

1. *DHCP Enable: Choose Yes to obtain 
IP/subnet/gateway/DNS server/WINS 
server addresses automatically from 
DHCP server. 

2. *IP Address: The Internet Protocol (IP) address 
assigned to your machine by your 
network administrator or by DHCP 
server. 

3. Subnet Mask: The net mask address assigned by your 
network administrator or by DHCP 
server. 

4. Gateway IP: The gateway IP address assigned by 
your network administrator or by DHCP 
server. 
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5. *DNS server: The IP address of DNS server assigned 
by your network administrator.  

6. *WINS Server:  The IP address of WINS server 
assigned by your network 
administrator. 

7. *SMTP Server: The IP address of your SMTP mail 
server assigned by your network 
administrator. 

8. SMTP Port: 

 

The port number of your SMTP Mail 
Server. 

9. *LDAP Server: 

 

The IP address of your LDAP server. 

10. LDAP Port: 

 

The port number of your LDAP server. 
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Note: 

1. DHCP server: With DHCP (Dynamic Host Configuration 
Protocol), a host can automatically be given a unique IP 
address each time it connects to a network--making IP 
address management an easier task for network 
administrators. If the DHCP server is available from your 
network, you do not need to enter TCP/IP, subnet mask, 
gateway, and DNS information. Instead, this information 
will be automatically given for the product. 

2. IP Address: An IP (Internet Protocol) address uniquely 
identifies a host connection to an IP network. System 
administrator or network designer assigns the IP address. 
The IP address consists of two parts, one identifying the 
network and the one identifying your node. The IP 
address is usually written as four numbers separated by 
periods. Each number can be zero to 255.  For example, 
10.1.30.186 could be an IP address. 

3. SMTP: Stands for Simple Mail Transfer Protocol.  It is the 
main communication protocol used to send and receive E-
mail on the internet. 

4. DNS: Stands for Domain Name System. The DNS server 
identifies hosts via names instead of IP addresses. If the 
DNS server is available on your network, you can enter 
the domain name instead of digits for the IP address. 

5. WINS: Stands for Windows Internet Naming Service. 
WINS resolves Windows network computer names (also 
known as NetBIOS names) to Internet IP addresses, 
allowing Windows computers on a network to easily find 
and communicate with each other. 

6. LDAP: Stands for Lightweight Directory Access Protocol. 
LDAP enables users to access directories and address 
books directly from external networked devices to 
simplify document distribution.  
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2. Scanner Installation 
 

 

2.1 Precautions 

 
 Keep the scanner out of direct sunlight.  Direct exposure 

to the sun or excessive heat may cause damage to the 
unit. 

 Do not install the scanner in a humid or dusty place. 

 Be sure to use the proper AC power source. 

 Place the scanner securely on an even, flat surface.  
Tilted or uneven surfaces may cause mechanical or 
paper-feeding problems. 

 Retain the scanner box and packing materials for 
shipping purposes. 
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2.2 Connecting to Power  

Before connecting, make sure the power switch is off. 

Plug the small end of the power adaptor into the power jack of 
your scanner.  Insert the other end to an appropriate power 
outlet. 

 
 

 

2.3 Turning on the Power  

Press the Power Switch button on the front panel, the Power 
LED will flash.  When it is finished and ready to scan, the LED 
indicator will stop flashing and become steadily on.  To turn 
off the scanner, press the Power Switch button for about 3 
seconds, the Power LED will be off. 
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2.4 Connecting to a Network Cable 

 
1. Connect one end of your network cable to an available port 

of the switching hub of your LAN. 
 

 
 

2. Connect the other end to the LAN port marked  at the 
back of the product as shown. 
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2.5 Obtaining the Product’s IP Address via DHCP 

If you connect the product to your computer via a network 
cable, you need to specify an IP address for the product. An IP 
address can be obtained automatically through the DHCP server 
by default, or you may specify a static IP address via the 
product’s embedded web page. Please follow the steps in below 
to configure the IP address of the product. 
 
To obtain the product’s IP address via DHCP, 
 
1. Turn on the scanner by pressing the Power button. 
 

2. Press  key on the panel and then choose [Network] on 
the LCD screen. 

 
 
 
 
 
 
 
3. The product’s IP address through DHCP server will be 

displayed. (Default DHCP)  (For example, 10.1.20.25) 
 
 
 
 
 
 
 
 
 
 

 <Information> 
Scanner 
Network 

<Wired> 
IP Address 
10.1.20.25 



User’s Manual 
 

 2-5 

 

2.6 Setting the Product’s Date and Time 

To set the product’s date and time, 
 
1. Open your browser and type the product’s IP address on the 

URL field to prompt the product’s embedded web page.  

To access complete information of the web page, please 
login with the default user name and password – [admin]. 
The password can be changed later in the web page. 

 
 

2. Choose [Device Management]>[General], and then 
revise current date and time. Or specify your NTP server. 

 

4.     Click [Update] to save the setting and exit the page.

Device 
Management
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2.7 Specifying the Product’s Mail Server 

To use the scan-to-email feature, you must specify the product’s 
SMTP server or LDAP server if you wish to import an address 
book from other devices.  
 
To specify the SMTP and LDAP server, 
 
1. On the product’s web page, choose [Network]>[Mail 

server]/[LDAP Server] option to prompt the [Mail 
server]/[LDAP Server] page.  

 
 
2. Enter your mail server information. Enter authentication 

information if required. (See the following screen as an 
example.) 

 
E-mail Server Setting  
Mail Server Enter the IP address of your SMTP server. 

SMTP Port 
# 

Enter the port number of the SMTP server. 
* 25 

Device E-
mail 
Address 

Enter the device’s E-mail address. If the 
[From] address has not been set in the E-
mail setting, this address will be shown as 
the [From] address from outgoing mails.  

Authenticat
ion Method 

Enter the email authentication method.  
Choice: *None, SMTP, POP3 

Mail 
Server 
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Encrypt Choose the encryption method of your 

emails to the SMTP server.  
Choice: *None, STARTTLAS, SSL/TLS 

Login Name Enter the login name for SMTP authentication.  

Password Enter the password for SMTP authentication.  

LDAP Server Setting 
LDAP Server 
IP or URL  

Enter the IP address or the URL of your LDAP 

server. 
Port # Enter the port number of the LDAP server. 

* 389 
Login Name Enter the login name of the LDAP server. 

Note: 

1. In Microsoft Active Directory, some servers 

may require you to add “domain name” as 

your full login name.  For example, if your 

domain name is “company” and your user 

name is “administrator”, then your full 

login name is “company\administrator”. 

2. When your LDAP server requests an 

“anonymous login”, please leave your 

login name and password blank instead of 

typing “anonymous” as your login name 

and password. 

Password Enter the password of the LDAP server. 
Search Root Enter your base DN.  Base DN (distinguished 

name) identifies the starting point of a search.  

A dn indicates what record to view in an LDAP 

tree.  The top level of the LDAP directory tree 

is the base, referred to as the "base DN".  For 

example, you could indicate a base of 

dc=com,dc=net for a search that starts at the 

top and proceeds downward. 
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Search 
Attribute 

cn 

Obtain E-mail 
Address 
From 

mail 

Timeout(seco
nd) 

The specified time to connect  the LDAP 
server. 

Authenticatio
n Type 

Choice: Anonymous, Simple 

 
 

 Note: Please check the SMTP server and LDAP server 
information with your Network Administrator. 

 
 

3. Click [Update] to save the setting and exit the page. 
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Note: 
1. The login name is case-sensitive and is up to 32 digits 

or characters. 
2. The password is case-sensitive and is up to 16 

characters. 
3. LDAP Search: 
 This machine supports two types of authentication, 

simple and anonymous, to login your LDAP servers. 
 This machine allows up to 100 match results in a single 

search. 
 The attributes such as “cn” and “mail” have been 

predefined as the search field.  Therefore, if your 
search text is “m”, the LDAP search engine will search 
the name or the email address that contains the 
character “m”.  For example, you might get the return 
match results such as “mary, mary@abc.com”, or “jack, 
jack@abc.com”. 

mailto:mary@abc.com�
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3. Setting Up and 
Managing Destinations  

 
 
 
This section provides procedure for the administrator to setup 
and manage destinations including E-mail addresses or network 
folders to distribute the scanned document on the network.   
 

3.1 Setting Up Your E-mail Address Book 

To create an E-mail Profile, you must first setup your E-mail 
Address Book. This section provides procedure for the 
administrator on how to setup E-mail Address Book. 

3.1.1 Adding A New E-mail Address 
 
Follow these steps to setup your Address Book. 
 
1. Open your browser and type the product’s IP address on 

the URL field to prompt the product’s embedded web page.  

To access complete information of the web page, please 
login with the default user name and password – [admin]. 
The password can be changed later in the web page. 

 
 
2.    Choose [Address Book] to prompt the [Address Book] 

page.  
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3. On the [E-mail List] tab, choose [New] to prompt the 

[Add a New E-mail Address] page. 

 

4. Enter your E-mail address and its description. 
 
5. Modify your address information. Click [Submit] to save 

the setting or [Quit] to leave the page without saving any 
setting. 

 
Note:  
Up to 200 E-mail addresses can be entered in the Address 
Book. 

3.1.2 Deleting A Current E-mail Address 
 
To delete a current E-mail address, 

1. Repeat Step 1 to Step 2 from the previous section, Adding 
a New E-mail Address.  The [Address Book] page 
appears.  
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2. Choose the address you want to delete from the list and 
then choose [Delete] to erase the address.  A 
Confirmation dialog box appears to confirm your deletion. 
Click [OK] to confirm or [Cancel] to exit. 

 
 

3.1.3 Modifying A Current E-mail Address 
 
To Modify a current E-mail address, 
 
1. Repeat Step 1 to Step 2 from the previous section, Adding 

a New E-mail Address.  The [Address Book] appears.  

2. Choose the address you want to Modify from the list and 
then choose [Modify] to prompt the [Modify E-mail 
Addresses] page. 

3. Modify your address information. Click [Submit] to save 
the setting or [Quit] to leave the page without saving any 
setting.  

 

3.1.4 Adding A New E-mail Group 
 
To send multiple addresses simultaneously at one time, you 
can create address group to speed up the process.  Up to 20 
addresses can be included in one group and a total of 20 
groups can be created in the Address Book. 
 
1. Repeat Step 1 to Step 2 from the previous section, Adding 

a New E-mail Address.  The [Address Book] appears.  

2. Click [Group List] and then choose [New] to prompt the 
[Add a New Group] page. 

3. Enter your group name and its description. 

4. Choose the address from the right side and click  to add 
a member to the group. 

5. Click [Submit] to save the setting or [Quit] to leave the 
page without saving any setting.  
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3.1.5 Deleting A Current E-mail Group 
 
To delete a current E-mail group, 
 
1. Repeat Step 1 to Step 2 from the previous section, Adding 

a New E-mail Address.  The [Address Book] appears.  
 
2. Click [Group List] and choose the group you want to 

delete from the list and then choose [Delete] to erase the 
group.  A Confirmation dialog box appears to confirm your 
deletion. Click [OK] to confirm or [Cancel] to exit. 

 

3.1.6 Modifying A Current E-mail Group 
 
To Modify a current E-mail group, 
 
1. Repeat Step 1 to Step 2 from the previous section, Adding 

a New E-mail Address.  The [Address Book] appears.  

2. Click [Group List] and choose the group you want to 
Modify from the list and then choose [Modify] to prompt 
the [Modify E-mail Group] page. 

3. Modify your group information.  Choose the group member 
you wish to add and then click  to add the new member 
or click  to delete an old member from the group. 

4. Click [Submit] to save the setting or [Quit] to leave the 
page without saving any setting.  

 



User’s Manual 
 

 3-5 

 

3.1.7 Importing An E-mail Address Book 
 
To import an E-mail address book,  
 
1. Repeat Step 1 to Step 2 from the previous section, Adding 

a New E-mail Address.  The [Address Book] appears.  

2. Click [External Address Book] to prompt the [LDAP] 
page. 

 

3. Enter your search key word, for example, ma. 

4. In a second, the search result will be displayed. 

 

5. Choose the E-mail address which you want to import to 
the device and click the [Import to E-mail List] tab. 

6. The selected E-mail addresses will be imported and 
included in your E-mail list as shown in below.   
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3.2 Setting Up Your E-mail Profiles 

This section provides procedures to setup your E-mail profile to 
send the scanned document to your recipients. 
 

3.2.1 Adding A New E-mail Profile 
 
To create an E-mail Profile, follow these steps: 
 
1. Open your browser and type the product’s IP address on 

the URL field to prompt the product’s embedded web page.  

To access complete information of the web page, please 
login with the default user name and password – [admin]. 
The password can be changed later in the web page. 

 
 
2. Choose [E-mail Profiles] to prompt the following page.  
 

 
 

 

E-mail Profiles 
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3. Choose [New] to prompt the [Add a New E-mail 
Profile] page. 

 

 
 
Enter the following information respectively: 
 

Item  Description 

Profile 

Name 

Enter the name of your profile. The name will be 

shown in the LCD screen.  

To Select the recipient’s E-mail address from the 

Address Book. 

CC Select the CC E-mail address from the Address 

Book. 

BCC Select the BCC E-mail address from the Address 

Book. 

Subject Type your subject. 

From Select the sender’s E-mail address from the 

Address Book. 

File Name Enter the file name of your attachment. 

Reply to  Select the E-mail address you wish to reply to. 

Text Type your email message here. 

File 

Separation 

Choice: 1MB/3M/5M/10M/30MB/Unlimited 

Scan Option 

Profile 

Choose your scan option profile. (*Default) 

 
4. Click [Submit] to save the setting and exit the page. 
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3.2.2 Deleting A Current E-mail Profile 
 
 
To delete a current E-mail profile, 
 
1. Repeat Step 1 to Step 3 from the previous section, Adding 

a New E-mail Profile.  The [E-mail Profiles] page 
appears.  

 
2. Choose the E-mail Profile you want to delete from the list 

and then choose [Delete] to erase the profile.  A 
Confirmation dialog box appears to confirm your deletion. 
Click [OK] to confirm or [Cancel] to exit. 

 
 

3.2.3 Modifying A New E-mail Profile 
 
 
To Modify a current E-mail group, 
 
1. Repeat Step 1 to Step 3 from the previous section, Adding 

a New E-mail Profile.  The [E-mail Profiles] page 
appears.  

2. Choose the E-mail Profile you want to Modify from the list 
and then choose [Modify] to prompt the [Modify E-mail 
Profile] page. 

3. Modify your profile information.   

4. Click [Submit] to save the setting or [Quit] to leave the 
page without saving any setting.  
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3.3 Setting Up Your Filing Profile 

The section provides procedure on how to setup your filing 
profile to send your scanned document to the specified 
network. 
 

3.3.1 Adding A New Filing Profile 
 
To create a Filing Profile, follow these steps: 
 
1. Open your browser and type the product’s IP address on 

the URL field to prompt the product’s embedded web page.  

To access complete information of the web page, please 
login with the default user name and password – [admin]. 
The password can be changed later in the web page. 

 
 
2. Choose [Filing Profile] to prompt the following page.  

 
 

 

Filing Profiles 
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3. Choose [New] to prompt the [Add a New Filing Profile] 

page. 
 

 
 

Enter the following information respectively: 
 

Item  Description 

Profile 
Name 

Enter the name of your profile. The name will 
be shown in the LCD screen.  

Target 
URL 

Choose your protocol or enter the IP address 
and the shared folder name of network 
server. Choice: FTPS: //, FTP: //, CIFS: \\ 

FTP: If you have not established a folder in 
the FTP server, please do not enter the folder 
name in the URL address. 

CIFS: You must set a folder in the CIFS 
server or your scanned image may not be 
uploaded successfully. 

Port  Enter the port number of the filing server. 

* 21 (FTP), 139 (CIFS) 

Login 
Name 

Enter the user name of the filing server.   

Password Enter the password of filing server.   
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File Name Enter your desired prefix for the file name. 
Naming Method：
Prefix_YYMMDDHHMMSS_xxx.file format. 

For example,
「DOC_150213144840_001.pdf」
indicates 2015 (year) 2 (February) 13 
(date) 14 (hour) 48 (minute) 40 (second) 
001 (serial number)  

Report to 
E-mail 

Enter an E-mail address if you wish to send 
the filing report to the E-mail. 

Scan 
Option 
Profile 

Choose your desired scan option profile. 

 
4. Click [Submit] to save the setting or [Quit] to leave the 

page without saving any setting. 
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3.3.2 Deleting A Current Filing Profile 
 
To delete a current filing profile, 
 
1. Repeat Step 1 to Step 3 from the previous section, Adding 

a New Filing Profile.  The [Filing Profile] page appears.  
 
2. Choose the Filing Profile you want to delete from the list 

and then choose [Delete] to erase the profile.  A 
Confirmation dialog box appears to confirm your deletion. 
Click [OK] to confirm or [Cancel] to exit. 

 
 
 

3.3.3 Modifying A New Filing Profile 
 
 
To Modify a current filing profile, 
 
1. Repeat Step 1 to Step 3 from the previous section, Adding 

a New Filing Profile.  The [Filing Profile] page appears.  

2. Choose the Filing Profile you want to Modify from the list 
and then choose [Modify] to prompt the [Modify Filing 
Profile] page. 

3. Modify your profile information.   

4. Click [Submit] to save the setting or [Quit] to leave the 
page without saving any setting.  
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4. Operation 
 

4.1 Loading Your Paper 

4.1.1 Notice on Using the ADF 
 
Before using the ADF, please make sure that your paper meets 
the following specifications: 

 

 Document(s) can range in size from 50 x 50 mm (2 x 2 
in.) to 216 x 356 mm (8.5 x 14 in.). 

 Document(s) can range in weight from 27 ~ 413 g/m2 (7 
~ 110 lb.)  

 ID cards up to 1.25 mm (0.05 in.) thick  

 Document(s) should be square or rectangular and in good 
condition (not fragile or torn). 

 Document(s) should be free of curl, wrinkle, wet ink, or 
punch holes. 

 Document(s) should be free of staples, paper clips, paper 
sticky notes. 
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4.1.2 Loading Your Document in the ADF Paper Tray 
 

Fanning Your Document 
 

Note: 
To avoid occasional multi-feeds or paper jams, please fan 
your documents and align the top edges before feeding them 
into the scanner.  

 

1. Hold both ends of the documents and fan them a few 
times. 

 

2. Rotate the documents by 90 degrees and fan them in the 
same manner. 

3. Align the edges of the documents in a step-like pattern 
(see picture below). 

 
 

 
 
 

Step-like  

Scanning 
Direction 
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Document Feeding 
 

1. Unfold the document feeder and its extension. 

2. Unfold the output tray and raise the paper stopper. 
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3. Raise the paper guide to hold your multi-page 
document. 

 

4. Raise the paperweight. 
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5. Slide the position adjustor inward  to make the output 
tray in a flat position . 

 

 

6. Load a stack of document face down with the top of the 
pages pointing into the feeder. 

 

7. Verify that the paper guides are aligned with the edges 
of the stack.  
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Note: The [Paper Width] switch: 

If your document width is 216 mm (8.5 in.): 

If your document width is 216 mm (8.5 in.), slide the 
[Paper Width] switch DOWN to fix your paper guide to 
conveniently load the letter-size document. 

If your document width is larger than  216 mm (8.5 in.): 

If your document width is larger than  216 mm (8.5 in.) 
such as invoices with punch holes, slide the [Paper 
Width] switch UP and move the paper guide to the right 
end to load your documents.  

  

 

  

 

 

Slide DOWN the [Paper 
Width] switch to set your 

paper width to 216 mm  
(8.5 in.) 

Slide UP the [Paper 
Width] switch to set 

your paper width larger 
than 216 mm (8.5 in.) 
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4.1.3 Scanning Cards 
 
To scan cards, it is recommended to press down the paper 
weight and then raise the output tray to keep the cards from 
falling apart. 
 
1.    Lift the output tray up to make the output tray in an 

angled position.  

 

2.   Press down the paper weight. 

 

3.    Load your cards horizontally into the paper tray.  Align 
the paper guides and make sure the edges of cards 
slightly touch the paper guides on both side as 
illustrated. 

8B 
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4.1.4 Scanning a Stack of Document with Various sizes 
and Weights 

 
When scanning a batch of documents with different sizes and 
weights, be sure to follow these guidelines to avoid a skewed 
image or a paper jam: 
 
1. Align the documents TOP EDGE first in the sequence of 

paper size from large to small. 
 

 
 
2. If two pages are of the same size yet with different weight, 

arrange these pages in the sequence of paper weight from 
heavyweight to lightweight.  
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3. Align the edges of the documents by tapping the bottom of 

the stack against the table top. 
 

 
 
4. Center these pages in the document feeder and make sure 

that the edges of page of the largest size slightly touch the 
Paper Guide. 
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4.2 Scanning and Sending Your Scanned Image to E-

mail 

Before You Begin:  
Before scanning and sending your scanned image as an 
attachment to your E-mail, make sure you have setup your E-
mail profile first as described in the preceding section, 3.2 
Setting up Your E-mail Profile.  

 
To start a scan and send the scanned image as an attachment 
to your E-mail, 
 
1. Use / to scroll to [Email Profiles] on the LCD display 

and then press the   key. The current E-mail profile will 
be shown. 

 
 
 
 
 
 
 
 
2. Choose the E-mail profile you wish to send the scanned 

image to. 
 
3. Press the [Scan] button to start a scan. 
 
4. The scanner starts feeding your document and sends the 

scanned image to your E-mail. 
 

 
 
 
 

E-mail Profiles 
Filing Profiles 
Scan to USB 
BM2 Air 
AP Mode 

E-mail Profile 1 
E-mail Profile 2 
E-mail Profie 3 

E-mail Profile 
Scanning 1 
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4.3 Scanning and Sending Your Scanned Image to a 

Network Folder 

 

Before You Begin:  
Before scanning and sending your scanned image to a network 
folder, make sure you have setup your E-mail profile first as 
described in the preceding section, 3.3 Setting up Your Filing 
Profile.  

 
To start a scan and send the scanned image to a network 
folder,  
 
1. Use  to scroll down to [Filing Profiles] on the LCD 

display and then press the   key. The current Filing 
profile will be shown. 

 
 
 
 
 
 
 
 
2. Choose the Filing profile you wish to send the scanned 

image to. 
 
3. Press the [Scan] button to start a scan. 
 
4. The scanner starts feeding your document and sends the 

scanned image to a specified network folder. 
 

 
 
 
 

E-mail Profiles 
Filing Profiles 
Scan to USB 
BM2 Air 
AP Mode 

Filing Profile 1 
Filing Profile 2 
Filing Profile 3 

Filing Profile 
Scanning 1 
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4.4 Scanning and Sending Your Scanned Image to a USB 

Flash Drive 

 
To start a scan and send the scanned image to an inserted USB 
flash drive,  
 
1. Insert a USB flash drive to the flash drive port on the left 

side of the scanner. 

 
 
2. Use  to scroll down to [Scan to USB] on the LCD display 

and then press the   key. The current scan profile will 
be shown. 

 
 
 
 
 
 
 

3. Choose your desired scan profile from the list. 
Or choose [default] to check and select your desired scan 
settings respectively. For example, use  to select your 

desired file format and then press the   key to go to the 
next item. Choice: *MPDF, TIFF, MTIFF, JPEG, PDF (*: 
default).  
 
 
 
 
 
 

E-mail Profiles 
Filing Profiles 
Scan to USB 
BM2 Air 
AP Mode 

default 
scan profile 1 
invoice 

<File Format> 
MPDF 
TIFF 
MTIFF 
JPEG 
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a. Use  to select your desired paper size and then press 

the   key to go to the next item. Choice: Auto, *A4, 
Letter, Legal, 4x6, 5x7. (*: default) 

 
 
 
 
 

 
b. Use  to select to scan one side or two sides of your 

document and then press the    key to go to the 
next item. Choice: *Simplex (1-Sided), Duplex (2-
Sided) (*: default) 

 
 
 
 
 
 
c. Use  to select your desired color mode and then 

press the   key to go to the next item. Choice: 
*Color, Gray, BW (*: default) 

 
 
 
 
 
 
d. Use  to select your desired document type and then 

press the   key to go to the next item. Choice: 
Photo, Text, *Mix (*: default) 

<Scan Side> 
Simplex 
Duplex 
  

<Color Mode> 
Color 
Gray 
BW 

<Paper Size> 
Auto 
A4 
Letter 
Legal 

<Doc Type> 
Photo  
Text 
Mix 
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e. Use  to select your desired resolution and then press 

the    key to start a scan. Choice: 150 dpi, *200 
dpi, 300 dpi, 600 dpi  (*: default) 

 
 
 
 
 

    
f. The scanner starts feeding your document and sends 

the scanned image to your USB flash drive. 
 

 
 
    

<Resolution> 
200 dpi 
300 dpi 
600 dpi 

Scan to USB 
Scanning 1 
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5. Setting up and Managing 
Your Scan Settings for the 
Product 

 
 
The product allows you to set various scan settings to fit your 
different scanning task. The scan settings include basic image 
processing settings, such as, color/grayscale/black and white, 
output file format, resolution, paper size, one-sided or two-
sided.  
 

5.1 Modifying Your Scan Option Profiles 

This section provides procedure for the administrator on how to 
setup the scan option profiles to fit a variety of scanning tasks. 
 

5.1.1 Adding A New Scan Option Profile 
 
To add a new scan option profile, 
 
1. Open your browser and type the product’s IP address on 

the URL field to prompt the product’s embedded web page.  

To access complete information of the web page, please 
login with the default user name and password – [admin]. 
The password can be changed later in the web page. 
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2. Choose [Scan Option Profile] to prompt the [Scan 

Option Profile] page.  

3. Choose [New] to prompt the [Add a New Scan Option 
Profile] page. 

 

Refer to the following table to choose your selection 
respectively: 

 
Item  Description 

Profile 
Name 

Enter the name of your profile.   

Document 
Type 

Choose your document type. 

Choice: *Mixed, Photo, Text 

Text:  Suitable for document contains pure 
text.  

Photo: Suitable for document contains 
photos. 

Mix: Suitable for common business 
document with photo or text.  

File 
Format 

Choose your desired file format. 

Choice: JPEG, TIFF, MTIFF, PDF, *MPDF 

Color 
Mode 

Choose your desired color mode.  

Choice: *Color, Grayscale, Black and 
White 
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Paper Size Choose your desired paper size. 

Choice: Auto, 4x6, 5x7, *A4, Letter, 
Legal 

Resolution Choose your desired resolution for your 
scanning task. 

Choice: 150 dpi, *200 dpi, 300 dpi, 600 
dpi   

Scan Side Choose to scan 1-Sided or 2-Sided 
document. 

Choice: *Simplex (1-Sided), Duplex (2-
Sided).   

* default 
 
4. Click [Submit] to save the setting or [Quit] to leave the 

page without saving any setting. 
 
 

5.1.2 Deleting A New Scan Option Profile 
 
To delete a current scan option profile, 
 
1. Repeat Step 1 to Step 3 from the previous section, Adding 

a New Scan Option Profile.  The [Scan Option Profile] 
page appears.  

 
2. Choose the scan option profile you want to delete from the 

list and then choose [Delete] to erase the profile.  A 
Confirmation dialog box appears to confirm your deletion. 
Click [OK] to confirm or [Cancel] to exit. 
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5.1.3 Modifying A New Scan Option Profile 
 
To Modify a current scan option profile, 
 
1. Repeat Step 1 to Step 3 from the previous section, Adding 

a New Scan Option Profile.  The [Scan Option Profile] 
page appears.  

 
2. Choose the scan option profile you want to Modify from 

the list and then choose [Modify] to prompt the [Modify 
Scan Option Profile] page. 

 
3. Modify your profile information. 
 
4. Click [Submit] to save the setting or [Quit] to leave the 

page without saving any setting. 
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6. Configuring the Product 
 
 
The section provides procedure to configure system 
information, specify your network settings, create address 
book, set E-mail or Filing profile, update firmware, and 
export/import system data.    

6.1 Configuring the Product’s Device Management 

Information 

6.1.1  Configuring the Product’s General Information 
 
To change the product’s general information: 
 
1. On the product’s web page, choose [Device 

Management]>[General] to prompt the [General] 
page.  
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3.    Refer to the following table to change the product’s 

general information.  
 

Item Description 

Host Name Avision-xxxxxx: The host name for the 
scanner in a wired and wireless 
environment. Xxxxxx indicates the last six 
digits of the scanner’s Mac address. 

NTP Server Used to specify the product’s NTP server. 

Date Used to specify the product’s current date. 

Time Used to specify the product’s current time. 

The time format is 24-hour system. 

Time Zone Used to specify the time zone of your 

location.  

Power 

Saving 

Used to specify how long the product needs 

to enter the power saving mode after last 

action. Range: 1 ~ *240 minutes  

Auto Power 

OFF 

Used to specify how long the product needs 

to shut down automatically after last action. 

Range: 1 ~ 480 minutes 

Enable Auto 

Power Off 

Check to enable auto power off.   

Device E-
mail 
Address 

Enter device’s e-mail address. This 
address serves as [Report to E-mail] 
address in Filing function if you wish to 
send the filing report to an E-mail 
address. 
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Multi-Feed 
Detection 
Def. 

Used to enable or disable multi-feed 
detection via the ultrasonic unit. 
Ultrasonic Multi-Feed Detection allows 
you to set overlapped document by 
detecting paper thickness between 
documents.  

Choice: On/* Off 

Return to 
Main 
Screen 

Used to specify a timeout period after 
your last action to return to the main 
screen.  

Choice: *30 Sec, 1 Min, 3 Min, 5 Min 

Disable: Check [Disable] to set no 
timeout. 

Admin Profile  

User Name If desired, change the default user name –

[admin] to login the web page. 

Password If desired, change the default password – 

[admin] to login the web page. 

* : Factory Default 
 
 
 
4.    Click [Update] to save the setting. 
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6.1.2 Configuring the Product’s Function Lock 
 
The machine allows system administrator to disable the 
functions including multi-feed detection via ultrasonic or scan 
to USB.   
 
To disable multi-feed function via ultrasonic, 
 
1. On the product’s web page, choose [Device 

Management] and then [Function Lock]. 
 
2. Choose [Off] from the dropdown box of the [Multi-feed 

Detection] option. 
 
3. The multi-feed detection function via ultrasonic sensor will 

be turn off.  
 
 
To disable scan to USB function, 
 
1. On the product’s web page, choose [Device 

Management] and then [Function Lock]. 
 
2. Choose [Off] from the dropdown box of the [Scan to 

USB] option. 
 
3. The [Scan to USB] function will be turn off.  
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6.1.3 Sending the System Log 
 
The machine allows the system log file (a file records all the 
events/jobs that occur in the machine) to be sent to a specified 
server to review the log file for troubleshooting purpose.  
 
To send the system log file,  
 
1. On the product’s web page, choose [Device 

Management] and then [A+ Manager Settings]. 
 
2. Check [Enable] and then enter the IP address of the 

server you wish to send the log report. 
 
3. Click [Update] to complete and save the settings. The 

system log file will be sent to the server whenever there is 
a new job occurs in the machine.  

 

6.1.4 Configuring the Product’s Settings to Default 
 
The following system settings can be retrieved to factory 
default: Administrator and account user name and password, 
network settings, all configurations. 
 
To configure the product’s settings to default, 
 
1. On the product’s web page, choose [Device 

Management] and then [Reset to Default]. 
 
2. Choose the items you wish to configure them to default. 

Choice: Reset Admin, Reset Network Settings, Reset 
Admin and Network, Reset to Factory Default. 

 
3. The corresponding data will be reset.  
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6.2 Specifying the Product’s Network Settings 

6.2.1 Specifying the Product’s Wired Network Settings 
 
The machine allows the system administrator to specify the 
following network settings: wired network settings, wireless 
network settings, mail server information. Follow these steps to 
specify the network information. 
 
 
1. On the product’s web page, choose [Network] and then 

[Wired] option to prompt the [Wired Network] page. 
 

 
 

2. Refer to the preceding section 1.7 Pre-installation check 
list to specify the IP address for the product. 

 
3. After the IP address has been specified, choose [Update] 

to complete and save the settings. 
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Upload Certificate: 
 
If IEEE 802.1x authentication method has been used to access 
a network server, the product offers the administrator to 
upload the certificate information through the embedded web 
page. To upload the certificate files, follow these steps: 
 
1. Download the latest certificate files from your network 

administrator.  

1. Open your browser and type the product’s IP address on 
the URL field to prompt the product’s embedded web page.  

To access complete information of the web page, please 
login with the default user name and password – [admin]. 
The password can be changed later in the web page. 

 
2. On the product’s web page, choose [Network]>[Wired] 

to prompt the [Wired Settings] page. 

3. Turn on the option of [802.1x Auth. Setting Enable]. 

4. Click [Browse] on the item of [Root Certificate], [Client 
Certificate], [Client Key], and [Client Password] 
respectively to choose the certificate file on your 
computer. 

5. Click [Update] to start updating the certificate. 
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6.2.2 Specifying the Product’s Wireless Network 
Settings 

 
 
1. On the product’s web page, choose 

[Network]>[Wireless] option to prompt the [Wireless] 
page. 

 
2. Refer to the subsequent section – 7.2 Connecting to a 

Wireless Network to specify your wireless network 
settings. 

 
 
 
 
 
 

6.2.3 Specifying the Product’s Mail Server Settings 
 
1. On the product’s web page, choose [Network]>[Mail 

server] option to prompt the [Mail server] page. 
 
2. Refer to the preceding section - 2.7 Specifying the 

Product’s Mail Server to specify the mail server 
information. 
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6.3 Configuring the Profile Default for USB 

To change the profile default for scan-to-USB: 
 
1. On the product’s web page, choose [Profile Default] to 

prompt the [Profile Default ] page.  

 
 
2.    Make sure the [USB] tab has been selected.  

3.    Choose your desired default scan option from the list. 

Refer to the preceding section, 5.1 Modifying Your Scan 
Option Profiles, to make various scan options to fit a 
variety of scanning tasks. 

4.   Click [Update] to save the setting. 

 

6.4 Configuring the Profile Default for Filing 

To change the profile default for Filing: 
 
1. Repeat Step 1 to Step 2 from the previous section, 

Configuring the Profile Default for USB.  The [Profile 
Default] page appears. 

 
2. Choose [Filing] to prompt the [Profile Default for 

Filing] page. 
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2. Refer to the following table to enter your desired settings. 
  

Item  Description 

Target 
URL 

Choose the type of protocol of your filing 
server or enter the IP address and the shared 
folder name of your filing server.  Choice: 
FTPS: //, FTP: //, CIFS: \\ 

Report to 
E-mail 

Enter an E-mail address if you wish to send 
the filing report to the E-mail. 

Port  Enter the port number of the filing server. 

* 21 (FTP), 139 (CIFS) 

File Name Enter your desired prefix for the file name. 
Naming Method：
Prefix_YYMMDDHHMMSS_xxx.file format. 

For example,
「DOC_150213144840_001.pdf」indicates 
2015 (year) 2 (February) 13 (date) 14 (hour) 
48 (minute) 40 (second) 001 (serial number) 

Default 
Scan 
Option 

Choose the default scan option for the 
scanned image of the filing profile. 

 
3. Click [Update] to save the setting. 
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6.5 Configuring the Profile Default for E-mail 

To change the default setting for scan-to-E-mail: 
 
1. Repeat Step 1 to Step 2 from the previous section, 

Configuring the Profile Default for USB.  The [Profile 
Default] page appears. 

 
2. Choose [E-mail] to prompt the [Profile Default for E-

mail] page. 

 
 
3. Refer to the following table to enter your desired settings. 
  

Item  Description 

Default 
Subject 

Enter the default subject for all outgoing 
mails.  

Default 
From 

Enter your default From address for all 
outgoing mails. 

Default File 
Name 

Enter your default file name. 

Default 
Reply To 
Address 

Enter your default [reply to] address for 
all outgoing mails. 

Default File 
Separation 

Enter the default file separation limit of 
the attachment file for all outgoing mails. 

Choice:  1MB/3M/5M/10M/30MB/ 

Unlimited 
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Default 
Scan 
Option 

Choose the default scan option for all 
outgoing mails. 

 
4.    Click [Update] to save the setting. 
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6.6 Managing Web Site’s Accounts 

If the system administrator wish to add more users to access 
and manage the product’s web page, it is possible to add more 
users to login the web page through account management. 
 
To add a new account,  
 
1. On the product’s web page, choose [Account 

Management] and then [New] to add a new account.  

2. Enter user name and password for the new account. 

3. Click [Submit] to save the settings. 

4. A new account will be shown in the list.  

 
 
To Modify a current account,  
 
1. On the product’s web page, choose [Account 

Management]. 

2. Choose the account which you want to Modify. 

3. A [Modify] page will be displayed. Modify your user name 
or password. 

4. Click [Submit] to save the settings.   

 
 
To delete a current account,  
 
1. On the product’s web page, choose [Account 

Management]. 

2. Choose the account which you want to delete. 

3. A Confirmation dialog box will be prompted. Choose [Yes] 
to delete or [Cancel] to quit. 
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6.7 Updating the Firmware 

To update the product’s firmware, follow these steps: 
 
1. Download the latest firmware file from our web page at 

www.avision.com to your computer. 
 
2. Open your browser and type the product’s IP address on 

the URL field to prompt the product’s embedded web page. 
 

To access complete information of the web page, please 
login with the default user name and password – [admin]. 
The password can be changed later in the web page. 

 
3. On the product’s web page, choose [Firmware Update] 

to prompt the [Firmware Update] page. 

4. Click [Browse] to choose the firmware file on your 
computer. 

5. Click [Update] to start updating the firmware. 

6. Turn off and then turn on the scanner to complete the 
firmware update. 

 

http://www.avision.com/�
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6.8 Exporting and Importing System Data 

 
To easily manage several AN230W in the network, the machine 
provides a useful feature to allow system administrator to 
export the system data of one AN230W into a file and then 
import this data to other AN230W in the network.  
 
For example, the address book, filing profile, and default 
systems settings of one AN230W can be first exported to a file 
as a backup and then import these files to other AN230W. 
 
Follow the procedure described in below to export and then 
import your system data. 
 

6.8.1 Exporting System Data 
 
To export system data, 
 
1. On the product’s web page, choose [Import/Export]. 
 
2. Choose the system data you want to export. Choice: 

Address Book, Filing Profile, Settings (Device Management, 
Account Management, Mail Server/LDAP Server, E-mail 
Default, Filing Default).   

 
3. Choose [Export Now]. The selected system data will be 

exported into a file.  If [address book] is selected, an 
AN230W_addressbook.csv file will be generated. If [filing 
profile] or [settings] is selected, an AN230W_profile.json 
or AN230W_setting will be generated... 

 
4. Save the exported file into your computer as a backup.  
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6.8.2 Importing System Data 
 
To import system data, 
 
1. On the product’s web page, choose [Import/Export]. 
 
2. Choose the system data you want to import. Choice: 

Address Book, Filing Profile, Settings (Device Management, 
Account Management, Mail Server/LDAP Server, E-mail 
Default, Filing Default).   

 
3. On the Importing option, choose [Browse] to locate the 

system data which you have been previously exported.  
 
4. Choose [Import Now] to start importing the system data 

to your machine. The current system data will be 
overwritten.  
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7. Starting a Scan from Your 
Mobile Device 

 
 
With a built-in Wi-Fi module, the scanner can be converted into 
a wireless device.  When a mobile device is use, the scanned 
images can be received from the mobile device. 

7.1 Making Preparation 

To connect the scanner to a wireless LAN, prepare the 
followings: 
 
 An environment in which a wireless LAN is available 

When connecting the scanner to a wireless LAN, you may 
need information for a wireless access point such as an 
SSID (network name) and a security key (password). For 
details, contact your Network Administrator or refer to the 
manual for the wireless access point. 
 

 

 

 

Attention! 
Do not place obstacles that block radio waves (e.g. walls or 
metal plates) or devices that cause radio wave interference 
(e.g. cordless phones) within 100 mm of the scanner, or 
near your wireless access point. 
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 MB Application 
Download the MB Application on your mobile device from 
an application store such as Google Play. 

 
 
 
 
 
 
 
 

7.2 Connecting to a wireless network  

7.2.1 Connect to a Wi-Fi network in an AP (Access 
Point) mode  

 
In AP (Access Point) mode, your mobile devices and the 
scanner are connected wirelessly without an additional AP 
(Access Point) since the scanner itself works as an AP. 

 
 

1. Turn on the Wi-Fi switch on the back of the scanner. The 
Wi-Fi LED light will be flashing and then turn solidly on. 

 
2. On the control panel of your scanner, use ▼ to scroll down 

to [AP Mode] and then press  to select it. 

 

MB 
Application 

- AP (Access Point) 
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3. The SSID and IP Address will be displayed. 

 

 

 

 

 
Note: 
The IP address 192.168.200.1 is the permanent IP address 
for the scanner when it connects to a wireless network in 
AP mode. 

 
4. On your mobile devices, make sure Avision–xxxxxx 

(xxxxxx indicates the last six digits of the Mac Address) 
has been selected as your network name (SSID). 

 

Filing Profiles 
Scan to USB 
Scan to PC 
AP Mode 

SSID: 
Avision-DFAF37 
IP Address: 
192.168.2.101 
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7.2.2 Connect the scanner to a Wi-Fi network in a client 
mode (default mode) 

 
In a Client mode, your mobile devices and scanner are 
connected wirelessly through an additional AP (Access Point). 
This mode is also the default wireless mode. 

 
 
Connect Your Scanner to an AP (Access Point):  
 
Important:  
Note to connect the scanner in a wireless network, please first 
disconnect the Ethernet cable connecting to your scanner. 

a. Connect the scanner to a wired network via a network 
cable. 

 

b. Make sure the Wi-Fi LED light is flashing. If not, turn on 
the Wi-Fi switch on the back of the scanner. The Wi-Fi 
LED light will be flashing. 

-  AP (Access Point) 
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c. Press the [i] button on the control panel and then choose 
[Network]. The IP for the wired network will be 
displayed. 

 

 

d. Open your browser (i.e. 10 or above). 

e. Type ETHERNET IP address on the URL bar (for example, 
http://10.1.20.119) to prompt the embedded web page. 
Choose [Network Settings]>[Wireless] to prompt the 
wireless page.      

 

f. Select an AP(Access Point) and click [Connect] Connect 
the scanner to a specified Access Point, for example, 
SMCWBR14S-NL. 

 

 

<Wired> 
IP Address: 
10.1.20.119 
Mac Address: 

Wireless 

http://10.1.20.119/�
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g. In a few seconds, if the connection is successful, the 
connected Access Point will be marked with [connected] 
as shown. 

 

Note: 

1. The product does not allow the wired and wireless mode to 
work at the same time. Therefore, once the scanner has 
successfully connected to a wireless access point, the 
webpage which you have just connected via the Ethernet 
cable can no longer work. 

2. If you want to make the web page available to Modify the 
settings or connect the scanner to another wireless access 
point, please follow these steps to prompt the scanner’s 
web page: 

1). On your wireless computer or device, select the same 
AP (access point) as the scanner. For example, 
SMCWBR14S-NL. 

2). Open the browser of your wireless device. 

3). Type the wireless IP address for the scanner (press the 
[i] button on the control panel to find the wireless IP 
address) on the URL field. The scanner’s web page will 
be prompted. 

4). Modify the settings or follow step e ~ g to connect the 
scanner to another AP (access point).  
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Note: 
If your access point is set to not broadcast the SSID, you will 
have to manually add the SSID name on the product’s web 
page.  
1. Connect the Ethernet cable to the LAN port on the back of 

the scanner. 

2. Open your browser and type the wireless IP address on 
the URL field.  

3. Choose [Network]>[Wireless]> [Add AP] on the 
product’s embedded web page and enter the SSID 
name/security mode/encryption type/network key and 
then click [Apply] to search the wireless network 
manually. 

 

 
 

Your scanner supports the following authentication methods: 
 

Security mode Encryption method Key Index 

WEPAUTO WEP 1, 2, 3, 4 

WPAPSK TKIP, AES, TKIPAES X 

WPA2PSK TKIP, AES, TKIPAES X 

WPA1PSKWPA2PSK TKIPAES X 

 
 
 

Add AP 
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7.2.3 Connect to a wireless access point using the WPS 
button 

 
You may connect the scanner to a WPS compatible wireless 
access point by pressing the WPS button on the back of the 
scanner.  
 
Before You Begin! 
To enable the WPS connection of your access point, please 
refer to the user’s guide of your access point.   
 

Perform the following procedure to connect. 
 
1. Confirm your wireless access point/router has the WPS or 

AOSSTM symbol as shown below. 

           

2. Turn on the Wi-Fi switch on the back of the scanner. The 
Wi-Fi LED light will be flashing.  

3. Press the WPS button of your wireless access point. (You 
may refer to the user’s guide of your access point/router for 
instructions on how to use the WPS button.) 

 
 
4. Press and hold the WPS button on the back of the scanner 

for about 5 seconds within 2 minutes after pressing the 
WPS button of your wireless access point.  
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5. If the connection is successful, the Wi-Fi LED light of the 

scanner will turn solidly on.   

6. Check the AP name and IP address of the scanner by 
pressing the [i] button on the scanner and then use ▼ to 
scroll down to [Network] and then press  to select it. 

 

 

 

 

  

      
         If the AP name is your selected AP, it means the wireless 

connection via the WPS button is successful. 
 
 

<Wireless> 
AP: 
XXXXXXXX 
IP Address: 
10.1.23.156 

Information 
Scanner 
Network 
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7.3 Scanning a document from a mobile device 

Make sure that the MB Application (Scan App) has been 
installed on your mobile device. The MB Application can be 
purchased for free from an application store such as Google 
Play. 

 
1. Enable [Wi-Fi] from [Settings] of your wireless computer, 

smartphone, or tablet and then choose the same network 
name (SSID) of your scanner. For example, SMCWBR14S-
NL. 

 
 

2. Tap the MB app ( ) on the screen to launch the Scan 
Application. The main window will be displayed and the 
application will automatically search a scanner in the same 
wireless LAN. If successful, [Start scan] will be displayed 
at the bottom as shown below. 
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3. Check if the default settings meet your requirements. If 

not, change the scan settings to fit your specific scanning 
task. 

 
Item Description 

 

Resolution: Select your desired resolution. 
The higher resolution, the greater the image 
quality and disk space.  

Choice: *150, 200, 300 dpi 

 

Scan Size: Select your paper size or you may 
choose Auto to let the scanner detect your 
document size automatically.   

Choice: *Auto size, A4, LTR (Letter), LGL 
(Legal), 4x6, 5x7 

 

File Format: Select the file format for your 
image.  

Choice: *JPEG, PDF, TIFF 
Note:  
 The JPEG file does not support the B&W 

image. 

 The TIFF file format supports only the 
B&W image. 

ATTENTION: 
If the scanner is not found, please 
check the followings: 
1. The scanner is not ready yet. 

Tap [More Settings] and then 
[Search scanner] to search 
the scanner again. 

2. Check if the mobile device and 
the scanner are in the same 
wireless LAN.  
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Select to scan the front side (simplex) or 
both the front side and the rear side (duplex) 
of your document.  

Choice: *Simplex, Duplex 

Note: The duplex mode is available to scan 
from the auto document feeder only. 

 

Color Mode: Select your desired image mode.  

Choice: *Color, B&W, Gray 

* Default settings 
 
4. Load a page to the auto document or place a page on the 

flat bed. 
 
5. Tap the [Start scan] button. (Choose your scanner if 

there is more than one scanner connected to the network).  
In a second, the scanner begins scanning the document 
and the thumbnail scanned image will be displayed.   

 
  

 
 

6. Tap the thumbnail image to view the entire image. 
 

The 
Thumbnail 

Image 
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7.4    Scanning From A NFC-Enabled Mobile Device 

The scanner supports NFC (Near Field Communication), a 
short-range wireless communication technology. By placing an 
NFC-enabled mobile device over the NFC mark on the 
operation panel of the scanner, you can start a scan and 
receive images directly from your mobile device. 

 

Before Using the NFC Function:  
1. Download and install "MB" App. The Scan App can be 

purchased for free from Google Play. 
2. Make sure Wi-Fi is enabled for the scanner. 
 

Scanning with the NFC Function 
 
1. Load a document facing down to the feeder of the 

scanner. 

2. Hold your mobile device against the NFC logo on the 
operational panel of the scanner.  

3. If the NFC connection is successful, the MB app on your 
mobile device will be started.  
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4. Modify the scan settings to suit your need.  

5. Tap “Start scan” to start a scan. 
 
 

Note: 
The NFC function has to work while the Wi-Fi is enabled for 
both the scanner and your mobile device or the following 
conditions will occur: 

  
 If Wi-Fi has been enabled yet no Access Point has been 

connected or if Wi-Fi has not been enable on your 
scanner, the MB app will be launched and displayed “No 
Wi-Fi information”.  Tap “OK” and close the MB app.  

                 
Solution: 
On your scanner, enable Wi-Fi and then select an Access 
Point.  
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 If Wi-Fi has not been enabled on your mobile device, the 
MB app will guide you to enable Wi-Fi and then connect 
to the Access Point as illustrated in below: 

            
1. Enable Wi-Fi       2. Select SSID     3. Connecting Wi-Fi   4. Ready to scan 
 
 
 
 
 
Important: 
 Your mobile device must support NFC. 
 Make sure you turn on the NFC function on your mobile 

device and your scanner. 
 If your mobile device is not recognized, reposition your 

mobile device over the NFC logo and try again. 
 The screen and message displayed may vary depending 

on your mobile device. 
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8. Using the Product as a 
Regular Scanner 

 
 

8.1 Installing the Scanner Driver  

NOTE:  
1). To ensure your computer can identify the USB scanner, 

please install scanner driver first before connecting the 
scanner to your computer. 

2). The scanner driver contains TWAIN, and WIA driver.  After 
the installation of scanner driver is completed, this scanner 
allows you to scan via a TWAIN, or a WIA interface.  Start 
your TWAIN-compliant image editing software application 
to select a TWAIN or WIA user interface to start a scan.  
You may also launch Microsoft’s Scanner and Camera 
Wizard to scan via a WIA user interface. 

 
1. Place the supplied CD-ROM onto your CD-ROM drive. 

2. The software installation graphic appears.  If not, run 
“setup.exe”. 
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Contents on the installation graphic: 

 Install Scanner Driver:  To communicate with 
your scanner, you need to install the scanner driver.   

 Install Button Manager V2:  To use the buttons 
on the scanner, you need to install Button Manager 
V2.  To ensure Button Manager V2 works properly, 
please FIRST install scanner driver before installing 
Button Manager V2. 

 Install Virtual Scanner Link: To connect your 
computer to the scanner in the network, you need 
to install the Network Setup Tool. 

 Install Adobe Reader:  To view the user’s 
manuals for the scanner and Button Manager V2, 
you need to use Adobe Reader to open and view the 
manuals in pdf file format.  If you already have 
Adobe Reader installed on your computer, you may 
disregard this item. 

 Install AVScan X: To scan and organize your 
multi-page document(s), you can install the 
software application to manage them easily and 
effectively.   

 View Manual:  Click “View Manual” to view or 
print the detailed user manual for the scanner and 
Button Manager V2 respectively. 

 
3. Click Install Scanner Driver  to install the scanner driver 

and then click Install Button Manager V2 to install the 
Button Manager V2 unto your computer. 
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8.2 Connecting to Computer  

Via a USB Cable 
 
 
1. Connect the square end of the USB cable to the USB port of 

your scanner. Connect the rectangle end to the USB port at 
the rear side of your computer.  

 
 

2. The computer should detect a new USB device and prompt 
a “New Hardware Found” message. 

3. By following the on-screen instructions, click the Next 
button to continue. When the certification screen appears, 
click Continue Anyway to complete the installation. 

4. When the Finish dialog is prompted, click the Finish 
button.  
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Via a Wired Network 

 
1. Connect one end of your Ethernet LAN cable to an 

available port of your Ethernet Hub. 

2. Connect the other end to the port marked  at the back 
of the product. 
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8.3 Connecting to the Network Scanner 

Before connecting to the network scanner, make sure that 
Virtual Scanner Link (Network Setup Tool) has been installed 
onto your computer.  The Network Setup Tool is included in the 
supplied software CD. 

 

1. Start [Virtual Scanner Link] by choosing Start>All 
Programs>Avision Virtual Scanner>Virtual Scanner 
Link. The main window will be displayed and the 
scanners in your network will be searched automatically. 
In a few seconds, the result including the scanner model 
and scanner’s IP address will be displayed as shown. 

 

2. Choose the scanner you wish to connect and then press 
[Connect]. If connection is successful, a connection 
mark will be displayed as shown. 
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3. After the scanner has been connected successfully, 
launch your TWAIN-compliant image-editing software 
application to start a scan. 
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Note: 
 The network scanner can be used by one user at a 

time. If the network scanner is being used by other 
user, you will be prompted with a message to connect 
the scanner later.  When the scanner is available, you 
will also be prompted with a message to connect the 
scanner and start scanning your document. 

 If the network scanner has not been found, it is 
probably the scanner and your computer are not in the 
same LAN. In this case, you can assign a specific IP 
address of the scanner to let [Virtual Scanner Link] 
automatically search the scanner. Click the [Option] 
button, type your IP address on the [Searching 
Address] field (1), then click the [+] button (2) and 
finally click [OK] (3) to complete. 

 

 Searching Time: When the program is launched, it 
automatically searches the scanner in the network in 5 
seconds (default). The searching time can be changed 
from a range of 5 to 20 seconds. 

 If the [Virtual Scanner Link] program has been 
closed and then launched again, [Virtual Scanner 
Link] will automatically search and connect the 
network scanner it has previously connected to. 

 
 

(1)

(3)

(2)
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8.4 Verifying Your Scanner Installation   

To verify if your scanner installation is correct, Avision provides 
you a useful test program called Avision Capture Tool.  With 
this tool, you can perform simple scans and view the captured 
images.  In addition, it helps you complete your scan at a rated 
speed. 
 
The following procedure describes how to verify your scanner 
installation.  If the installation is not correct, please review the 
preceding section to check if the cable connection and scanner 
driver have been successfully installed.    
 
Before you begin, be sure the scanner is on. 
 
2. Select Start>Programs>Avision xxx Scanner>Avision 

Capture Tool. The Select Scanner Model dialog box will be 
displayed.  

 

 
 

3. Select your driver type and scanner model and click OK.  
The following Avision Capture Tool dialog box will be 
displayed. 
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4. Choose your desired file format from the File Format drop 
down list box. (Default is JPEG, other choice includes TIFF, 
MTIFF, PDF, MPDF, GIF, and BMP.) The supported file 
formats vary depending on your scanner model. 

5. Type your desired folder name and file name in the File 
Path box. (Default is C:\Documents and Settings\User 
Name\My Documents\My Scan\Image.) 

Note: If you do not wish to save the scanned image, 
deselect the Save button since default is Save Enable. In 
this case, the thumbnail view will be disabled.  And 
therefore, after viewing all the scanned images, only the 
last one will remain on the screen.   

6. Click the Setup button ( ) or choose Setup from the 
File menu to prompt the Scanner Properties dialog box. 

 
 
 
 
 
 
 
 
 
 
 

Setup    

Actual  
Size

Fit 
Page 

Scan 
File Format Save                             File Path 
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7. From the Image Selection Box, choose your desired image 

type for your scanned image.  (Default is Front B&W)  If 
you have a duplex scanner, choose Front and Rear to scan 
both sides of your document.  

8. Click OK to quit the Scanner Properties dialog box.  (To 
learn more details about the Scanner Properties dialog box, 
please see the subsequent chapter, Using the Scanner 
Properties Dialog Box.) 

9. Place your document face down on the document glass or 
face up in the auto document feeder. 

10. In the Scan Validation dialog box, click the Scan button 

( ) or choose Scan from the File menu. 

11. The document will be scanned and displayed in the Scan 
Validation screen.  After the scanned images have been 
displayed, your scanner installation verification is 
completed.  

Image 
Selection 

Box 
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12. You can view the scanned image in Fit Page ( ) or 

Actual Size (100%) button ( ) from the Viewing toolbars 
at the right side. 

13. Click the Close box or Quit from the File menu to exit the 
Scan Validation Tool. 

 

 

Display View 
Thumbnail View 
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8.5    A Glance of the Scanner Properties Dialog Box  

 
 
1. Tab Options Choice:  Image, Compression, Color Dropout, 

Paper, Multi-Feed Detection, Preview, Options, 
Settings, Information. 

2. Image 
Selection Box  

Choose your image type and the side of 
document you wish to scan.  Options vary 
based on type of scanner.  

3. Brightness Adjust the brightness level from –100 to +100.   
4. Contrast Adjust the contrast level from –100 to +100. 
5. Resolution Determine the quality of the scanned image.  

The industry standard is 200 dpi. 
6. Invert Reverse the color of your scanned image. 
7. Scan Source  Choice: Auto Document Feeder, Flatbed, 

Flatbed (Book), Automatic (varies due to 
different scanner model)  

8. Defaults Reset all values on the tabs to the factory 
default settings. 

 
 
 
 
 

3 
4 
5 
6 

 

7 

1 

2 

8 
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9. Using the Scanner 
Properties Dialog Box  

 
 
 
The Scanner Properties dialog box allows you to configure the 
scanner’s settings. It consists of several tabbed windows each 
of which will be described in this chapter. 
 
Note: In this chapter, all options are available based on a 
duplex (double-side) scanner. If you have purchased a simplex 
(single-side) scanner, all options are available for single sided 
only. 
 

  
The Scanner Properties dialog box 
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9.1 Buttons on the Scanner Properties Dialog Box  

 
 

The buttons on the Scanner Properties dialog box 
 

Buttons Description 

Defaults Click the Defaults button, the factory default 
settings will be shown on each tab.   

Cancel Click the Cancel button to leave the Scanner 
Properties dialog box. 
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The following table shows the default settings： 
 
Tab name Default settings 
Image Image：Front B&W 

Binarization：Dynamic Threshold 
Resolution：200 dpi 
Invert：Blank on White 
Scan Source：Auto Document Feeder 
Threshold：None 
Brightness：None 
Contrast：None 

Compression None 
Color Dropout None 
Paper Cropping：Automatic 

Deskew：Yes 
Orientation：Portrait 
OverScan：0.00 
Note: The availability of this option 
varies due to scanner model.  
Unit：Inch 

Multi-Feed 
Detection 

None 

Preview None 
Options Rotation Degrees：None 

Blank Page Removal：None 
Edge Fill：White，0 mm 
Image Control Option：None 

Setting Enable Energy Saver：Enable, 15 
minutes after last scan action 
Show Scanning Progress：Yes 
Show Warning Message：Yes 
Save Settings after Closing：Yes 

Imprinter Digital Imprinter 
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9.2    Showing or Hiding Tabs 
 

The [Scanner Properties] dialog box is displayed in default 
with three basic tabs - Image, Paper, and Information.  To 
show more tabs, click the [Scanner Properties] icon to access 
more scan settings.  
 
To show more tabs, 

1. Click the [Scanner Properties] icon ( ) on the upper 
left corner, and choose [Tab] to show available tab names. 
The available tabs include Compression, Color Drop out, 
Preview, Rotation, Separation, Multi-Feed, Options, 
Settings, and Imprinter. (Note: the options vary based on 
scanner model.)  

2. Choose the tab you want to display. The selected tab will 
be shown with a check mark and then displayed in the 
[Scanner Properties] dialog box.  

3. To access the settings, click the selected tab on the top of 
the [Scanner Properties] dialog box. The page of the 
selected tab will be displayed. 

 
To hide a tab window, 

1. Click the [Scanner Properties] icon ( ) on the upper 
left corner, and choose [Tabs] to show available tab 
names. 

2. Choose the tab you want to hide. Then, the selected tab 
will be hided in the [Scanner Properties] dialog box.  

Note: The [Image], [Paper], and [Information] tab can 
not be hided since they preprogrammed to be displayed by 
default.  
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9.3  The Image Tab  

The Image tab allows you to choose the front side and (or) the 
rear side of your document, the type of image, and to set 
several basic scan settings.  Note that except for the resolution, 
you can set individual scan settings for the front side and the 
rear side.  For example, all settings in the Image tab, 
Compression tab, Color Dropout tab can be set individually for 
the front and the rear side.  However, the settings in the Paper 
tab, the Option tab, and the Setting tab have to be set the 
same for the front and rear side.   
 

 
 

The Image tab dialog box 
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9.3.1 The Image Selection Box 

 

The Image Selection box includes the 
image type and document side option.  If 
you wish to scan both the front side and 
the rear side of your color document, you 
can check both Front Color and Rear Color 
at the same time.  Note the options vary 
based on type of scanner. 

 
Example 1：Scanning a two-sided color document, both 
sides in color 

 

Side/Image 
Selection 

 
Front 

 
Rear 
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Example 2：Scanning a two-sided color document, one 
in B&W, the other in color 

 

Side/Image 
Selection 

 

Front 
 

Rear 

 

Image Type Description 
Color Choose Color if you wish to scan a color 

image for your original in color.  
Gray Choose Gray image if your original contains 

actual shades of gray. 
B&W Choose B&W if your original contains only 

text, pencil or ink sketch. 

   
B&W Gra y Color 
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Front/Rear Auto Color Detection:  

Click to automatically detect and scan the front or the rear 
page of your color document in color image mode.  If your 
document is in colors, the scanner will automatically scan the 
document into a color image.  If your document is non-color, 
you can choose the output to be either B&W or Gray from the 
Non-Color Selection option.  This option is useful when you 
have a mixture of color and non-color document. 

Note:  If you choose Front Rear Auto Color Detection, you can 
not specify the image mode of your rear page and vice versas. 

 
Modes of Auto Color Detection: 
If [Front/Rear Auto Color Detection] is selected, its modes 
will be displayed. Choice includes Normal, Ignore Paper 
Color. For paper with background color such as invoices, 
choosing [Ignore Paper Color] will automatically remove the 
background color and enhance the detection accuracy. 
 

  
Normal Ignore single background 

color 
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Sensitivity of Auto Color Detection 

If your documents contain primarily B&W text and small 
amount of light or pale colors and you do not wish them to be 
recognized as color image to save the file size, you can 
increase the sensitivity value by moving the bar to the right to 
let these images to be detected as B&W. The value ranges from 
1 to 100.  The default is 37. 
 

 
Original 
 
 

  
Sensitivity: 1  

(The image is recognized 
as a color one) 

Sensitivity: 100 

(The image is recognized 
as a black and white one) 
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Same settings on both sides: 

Click to apply same scan settings for both sides of your 
documents. After checking this option, any settings you have 
changed will automatically applied to both the front side and 
the rear side. For example, if you choose your ideal resolution 
to be 300 dpi, this will be applied both to the front side and 
rear side of your document.
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9.3.2 Other Image Options 

 
Binarization This is the process of converting a 

grayscale or color image to a bi-tonal 
image. There are several different 
methods of performing this conversion.  
Options:  Dynamic Threshold, 
Dynamic Threshold (AD), Fixed 
Processing, Halftone 1~5, Error 
Diffusion. 

Dynamic Threshold:  Selecting 
Dynamic Threshold allows the scanner 
to dynamically evaluate each document 
to determine the optimal threshold value 
to produce the highest quality image.  
This is used to scan mixed document 
containing faint text, shaded background, 
or color background with a single setting.  
If Dynamic Threshold is selected, 
Threshold, Brightness, and Contrast are 
not available. 

 

Dynamic Threshold (AD):  Selecting 
Dynamic Threshold (AD) to perform 
the enhanced mode of the Dynamic 
Threshold feature. However, using this 
mode may slow down your scanning 
speed. 

 

Sensitivity of Dynamic Threshold 

Occasionally your scanned image may 
contain small dots or speckles. To remove 
these spots, increase the sensitivity value 
by moving the bar to the right. The value 
ranges from 1 to 30.  The default is 20. 
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 Fixed Processing:  Used for black-and-

white and other high contrast documents.  A 
single level is set to determine the black-
and-white transition. The threshold is 
programmable over the entire density 
range.  Fixed Processing sets Contrast to 
0.  If Fixed Processing is selected, 
Contrast is not available. 

 

Halftone:  In addition to the black and 
white display, Halftone can present a 
somehow gray shade of image by using 
different size of dots.  Halftone image looks 
like the picture we have seen in the 
newspaper.  Options include Halftone 1, 
Halftone 2, Halftone 3, Halftone 4, 
Halftone 5.  

 

Error Diffusion:  Error Diffusion is a type 
of Halftone.  Error Diffusion gives good 
image texture and makes text in images 
more readable than Halftone. 

 

 
Halftone Image 
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Error Diffusion Image 

 

 

  

Dynamic Threshold  Dynamic Threshold (AD)  
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Threshold Used to convert a grayscale image to a  

bi-tonal image. The value ranges from 0 to 
255. A low threshold value produces a 
lighter image, and can be used to subdue 
backgrounds and subtle, unneeded 
information. A high threshold value produces 
a darker image, and can be used to help pick 
up faint images.  
Adjust the threshold setting by dragging the 
Threshold sliding bar to the left or right to 
achieve the desired threshold setting. 

 

 
 

200 dpi, 
Threshold:50, 
Brightness: 0 

 
 

200 dpi,  

Threshold:100, 

Brightness: 0  
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Gray  
Document Type:  Choice:  Normal, Photo, Document   
Three options of document type are provided when you choose 
Gray as the image type for your scanned document.  Choice:  
Normal, Photo, Document.  

 Document: Choose Document if your original contains 
pure text or a mixture of text and graphic since it is an 
optimal setting for regular business document.  When 
using Document, only Threshold can be adjusted.   

 Photo: Choose Photo if your original contains photo to 
reproduce your photo in vivid grayscale image.  When 
using Photo, no Threshold and Contrast can be adjusted. 

 Normal: When using Normal, Threshold, Brightness, and 
Contrast can be adjusted.  

 
Threshold:  The value ranges from 0 to 255.  The default is 
230.  A low threshold value produces a lighter image, and can 
be used to subdue backgrounds and subtle, unneeded 
information. A high threshold value produces a darker image, 
and can be used to help pick up faint images. Adjust the 
threshold setting by dragging the Threshold sliding bar to the 
left or right to achieve the desired threshold setting. 
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Normal 

 
Photo 

 
Document 

(Threshold: 230) 

 

 
Normal 

 
Photo 

 
Document 

(Threshold: 230) 
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Brightness Adjusts the lightness or darkness of an 

image.  The higher the value, the brighter 
the image.  Drag the slider to the right or 
left to increase or decrease the brightness.  
The range is from –100 to +100. 

Contrast Adjusts the range between the darkest and 
the lightest shades in the image.  The 
higher the contrast, the bigger the different 
grayscale. Drag the slider to the right or 
left to increase or decrease the contrast.  
The range is from –100 to +100. 

 

   

Brightness: -50 Brightness: 0 
(Normal) 

Brightness: +50 

   
Contrast: -50 Contrast: 0 

(Normal) 
Contrast: +50 
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Resolution A good control of the resolution results a 

good detail of an image that scans.  The 
resolution is measured by dots per inch 
(dpi).  Normally, the greater the dpi number, 
the higher the resolution and the image file 
size.  Be aware that greater resolution takes 
more time to scan, and more disk space for 
the scanning image.  For your information, 
an A4 size color image scanned at 300 dpi at 
True Color mode consumes approximately 25 
MB of disk space. A higher resolution 
(usually means over 600 dpi) is only 
recommended when you need to scan a 
small area at True Color mode.  

Choose a resolution value from the drop 
down list. The default value is 200 dpi. 
Available resolutions are 75, 100, 150, 200, 
300, 400 and 600. Or you may choose your 
desired value by clicking the box in the right 
side of the drop down list and press the 
arrow key to select your desired value and 
then click the Add button to include it in the 
drop down list. Note:  The resolution is up to 
300 dpi if an imprinter or a MICR reader is 
installed or connected to the scanner. 

 
Resolution: 75 dpi 

 
Resolution: 150 dpi 

 



User’s Manual 

 9-20 

 
 
Invert Reverses the brightness and the colors in the 

image.  The default setting is Black on a White 
background.  Reverse mode is White on a Black 
background. For color images, each pixel will be 
changed into its complementary color at the 
command of Invert. 

 

 
Black on White 

 

 

White on Black  
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Scan 
Source 

Choice: 

 Auto Document Feeder:   Used to scan 
multiple pages. 

 Flatbed:  Used to scan a single page. For 
example, pages from newspaper clipping, 
paper with wrinkles or curls.  

 Flatbed (book):  Used to scan several 
inside pages from book. 

 Automatic:  Allow the scanner automatically 
set its scan source.  If Automatic is selected 
and there is document in both the auto 
document feeder (ADF) and the flatbed, then 
the scan source will be automatically set to 
ADF.  If Automatic is selected and there is 
document only in flatbed, then the scan 
source will be set to flatbed. 

 Merge Two Sides into One Image:  

If you have a sheet-fed duplex scanner with 
front input tray, you can scan an A3 size 
document with an innovative method.  Thus, 
fold your A3 size document into A4, and then 
load the paper in the front tray.  Choose 
Merge Two Sides from the Scan Source 
option and then the scanner is able to scan 
both sides of your document and merge two 
A4 images into one A3 image.  

When you select Merge Two Sides into One 
Image, the Cropping or Multi-feed function 
will be disabled. 

Note: This feature must be used with a 
carrier sheet. Regarding how to load a 
document with a Carrier Sheet, refer to 
Section 4.6.2, Other Paper Selection.  

Note the options vary based on type of 
scanner. 
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Note: If you have purchased a duplex sheet-
fed scanner, choose [Merge Two Sides] on the 
[Scan Source], then the scanner is able to scan 
both sides of your document and merge them 
into a single image. 

 

If “Merge Two Sides into One Image” is 
selected, its choice will be available including 
“Merge Horizontally”, “Merge Vertically”, “Merge 
Vertically (Back Side Flip)”.  If the reverse side 
of your document is upside down, choose 
“Merge Vertically (Back Side Flip)” and the back 
side will be automatically rotated 180 degrees 
and merged. 

 
 
 
 
 
 
 
 
 
 
 
 
 

Note the options vary based on type of 
scanner. 
 

 
 
 

Front 
Side 

Rear 
Side 

Merge Vertically 

Front 
Side 

Rear 
Side 

Merge Horizontally 
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Color 
Matching 

 

The purpose of Color Matching is getting the 
accurate color. This option uses the default 
parameters (ICC profile) to adjust the colors 
of the image.  

Choice: None, Document, Photo, Mixed 

 None: Choose “None” to disable this 
option. 

 Mixed: Choose “Mixed” if your original 
contains a mixture of text and graphic. 

 Document: Choose “Document” if your 
original contains pure text.     

 Photo: Choose “Photo” if your original 
contains photo to reproduce your photo 
in vivid color image.  

 

         
Normal 

 
After Color Matching 
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9.3.3 Scanning color images 

The following options are available for scanning color images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

 

9.3.4 Scanning grayscale images  

The following options are available for scanning gray images.  

 Brightness 
 Contrast 
 Resolution 
 Invert 

  

9.3.5 Scanning B&W images  

The following options are available for scanning B&W images.  

 Binarization (Dynamic Threshold) 
 Resolution 
 Invert 

 
Or 

 Binarization (Fix Processing) 
 Threshold 
 Brightness 
 Resolution 
 Invert 
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9.3.6 Modifying Profiles 

 
The Scanner Properties dialog box allows you to change and 
save your frequently used scan settings into a profile.  You can 
Modify these profiles by renaming or deleting them.  
 
To add a new profile, 
 
1. Customize your settings.  (For example, change your 

resolution, image type, cropping method, scan size, or 
other scan settings.)  

2. Click the Image tab and then choose “Profiles” to prompt 
the “Modify Your Profile” dialog box.  

 
 
3. Click “Add” to enter the name of the profile and then 

choose “Save”. 

 
 
4. The new profile will be saved and shown in the “Profiles” 

dropdown list box.  
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To load a profile,  
 
 
1. From the Image tab dialog box, choose your favorable 

profile from the “Profiles” dropdown list box. 

 

2. Your favorable profile will be immediately loaded and 
displayed on Scanner Properties dialog box. 

 
 
To delete a profile, 
 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Modify Your Profile dialog box. 

 
 
2. Choose the profile you want to delete from the dropdown 

list box. 
3. Click “Delete”.  A Confirm message “Are you sure you want 

to delete this profile?” is prompted. 
4. Choose “Yes” to delete or “Cancel” to quit. 
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To rename a profile, 
 
1. From the Image tab dialog box, click “Profiles” to prompt 

the Modify Your Profile dialog box. 

 
 
2. Choose the profile you want to rename from the dropdown 

list box and then click the Rename button. 
 
3. Enter new name for the profile. 

 
 
4. Choose “Save” to save the new profile or “Cancel” to quit. 
 
Note: 
 The preset default profiles include Flatbed, Simplex-B&W, 

200 dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, 
Duplex-B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 
200 dpi.  If you have a simplex or a sheetfed scanner, the 
duplex or the flatbed option will not be available. 

 If any setting for a current profile has been changed, a [*] 
sign will be marked before the name of current profile, for 
example, [* Duplex, Color, 200 dpi]. If desire, click the 
[OK] or [Scan] button and a dialog box will be prompted to 
let you save the new profile. 
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9.4 The Compression Tab 

The Compression tab allows you to compress your scanned 
image and choose the level of compression.  Bi-tonal images 
are normally compressed using CCITT standard called Group 4 
(G4).  Color and grayscale images are often compressed using 
JPEG technology.  Move the JPEG Quality slider to the right or 
left to increase or decrease the level of compression.  Note the 
greater the compression level, the lower image quality.  Default 
is 50%. 

 
Note that the compression depends on your image Modifying 
application.  If your image Modifying application does not 
support the type of compression format, then  either a warning 
message will appear or the image quality of the compressed file 
will not be acceptable.  
 
JPEG (Joint Photographic Modifyor Group).  This group 
developed and lent their name to a file compression standard 
for color and grayscale images that is widely used by scanners, 
and software applications.  On Microsoft Windows-based 
systems, a file with the extension .jpg has normally been 
compressed using this standard. 

 
For scanning color or gray images, the following compressions 
are available: 

 None 
 JPEG 

 
For scanning B&W images, the following compressions are 
available: 

 None  
 G4 
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The Compression tab dialog box 
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9.5 The Color Dropout Tab   

9.5.1 Color Dropout Selection 

The [Color Dropout] tab allows you to select either green, 
red, blue, or a color of your choice to remove the details of the 
selected color from a scanned image. This feature is used to 
sharpen your text when using OCR (Optical Character 
Recognition) software. Note this feature applies only to the 
gray or black and white image.  

Choice: None, Auto, Remove Red, Remove Green, 
Remove Blue, Custom 

- None: Does not remove any color. 
- Auto: Automatically outputs the image with the details of 

the primary color removed.  
- Remove Red/Remove Green/Remove Blue: Outputs 

the image with the details of the specified color removed.  
- Custom: Specify the color you wish to remove by entering 

its RGB (Red, Green, and Blue) value respectively.  
 
Advanced Options:  
- Quality Mode: Range: 0~20. Default: 10  

When [Quality Mode] is selected, you can determine the 
color to be dropped out using the [Filter Threshold] slider. A 
lower value will drop more of the selected color out, while a 
higher value will leave more of the selected color in.    

- Normal Mode: Use an optimized setting to determine the 
color.  
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Original 

 
Auto/Remove Green 
(normal mode) 

 
Remove Red (normal 
mode) 

 

Remove Green (quality 
mode: Threshold: 18) 

 

Preview the color dropout result:   

To preview the color dropout result, please follow these steps: 

1. Click the [Scanner Properties] icon ( ) on the upper 
left corner, and choose [Tab] to show available tab 
names. 

2. Choose [Preview] to show the Preview tab. 

3. Click the [Preview] tab to show the Preview page. 

4. Load your document to the scanner and click the 
[Preview] button to get a preview image. 

5. On the [Image] tab, click [Gray] or [Black and White] 
image mode and then choose [Custom] on the [Color 
Dropout] tab. A [Preview window] button will be 
displayed. 

6. Click the [Preview window] button to prompt the 
[Preview] window with the previewed image. 
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7. Move your cursor over the preview image. Your mouse 
cursor now becomes an Eyedropper.  

8. Click to select a color which you wish to remove. 

9. Click and hold your mouse button to view the result 
after removing the specified color.  If the result is 
satisfactory, click [OK] to close the Preview window. 

      

The Preview Window        The Color dropout result 
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The Color Dropout dialog box 
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To select a color on the Color palette, 
 
 
1. Click the Color 

Dropout tab from 
the Scanner 
Properties dialog 
box. 

 

2. Choose Gray or 
B&W from the 
Image Selection 
box and click 
“Custom” from the 
Color Dropout 
drop-down menu. 
The Color palette 
appears. 
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3. Move your cursor 

over the palette. The 
cursor becomes a 
cross sign. 

 

4. Click to choose a color. The RGB values are changed 
simultaneously. 
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9.6   The Paper Tab  

The Paper tab allows you to define values relating to image 
output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed 
Detection).  
 

 

The Paper tab dialog box 
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9.6.1 Cropping  

Cropping allows you to capture a portion of the document 
being scanned.  Choice:  Automatic, Automatic (36”), 
Fixed to Transport, EOP (End of Page) Detection, 
Automatic Multiple, Relative to Documents. 

Options Description 

Automatic Automatic adjusts the cropping window 
according to different document sizes and 
automatically straighten a skewed 
document. Use this option for batches of 
mixed-sized documents. 

Automatic 
(36”) 

Automatically adjusts the cropping window 
according to different document sizes 
smaller than 36” and automatically 
straighten a skewed image. Use this option 
for batches of mixed-sized document.  

Note: The availability of this feature 
varies due to scanner model. 

Fixed to 
Transport 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-sized documents.  If you select this 
option, you can use the arrow keys to 
define the x and y offset values, width and 
length to redefine your scanned area.  The 
Display window will show image placement 
as you change the values. 

EOP (End of 
Page) 
Detection 

This feature allows you to define the area 
or zone to be imaged.  Use for batches of 
same-width but different length 
documents.  If you select this option, you 
can use the arrow keys to define the x and 
y offset values, width and length to 
redefine your scanned area.  The Display 
window will show image placement as you 
change the values. 
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Automatic 
Multiple 

This option allows you to place various 
sized documents such as photos, ID Cards, 
or business cards on the flatbed (if 
available) and lets you create multiple 
individually cropped images in one scan. 
Note: To correctly create multiple images, 
please make sure there is at least 12mm 
(0.5”) of space between each document. 

Relative to 
Document 

This option allows you to crop different 
areas on your documents and deliver these 
images in B&W, Gray, or Color separately.  
For example, there are applications which 
require you to store the entire document in 
B&W and a part of the document in color to 
save storage space.  This is useful for 
documents where a photograph or 
signature appears in a consistent area on 
the document such as resumes, and so on. 

 

The following options are only available when Fixed to 
Transport is selected.  

 X-Offset — the distance from the left end of the 
scanner to the left edge of the scanning area.  

 Y-Offset — the position from the top end of the 
document to the top end of the scanning area.  

 Width — the width of the scanning area.  

 Length — the length of the scanning area.  

 Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected. 

 — relocate the scan area by click the arrow key on 
the cross sign while retain the scan size.  View the result 
from the Display window.   
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The Adjustment option is available when Automatic is 
selected.  

 Adjustment —adds a positive/negative margin value 
Top/Bottom or toward left/right of the image. 　
Adjustment is used when the automatic document feeder 
is used. Adjustment reduces the possibility of corner 
clipping on skewed images. To set Adjustment values, use 
the UP/Down buttons to select where you want to apply 
Adjustment values: Top/Bottom or Left/Right, and then 
select the amount of inches/mm/pixels applied. Select a 
value within the range of 0.00 to 1.00 / -1.00. 
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Relative to Document: (used for batches of same-sized 
documents) 

This option allows you to crop different areas on your 
documents and deliver these images in B&W, Gray, or Color 
separately.  For example, there are applications which require 
you to store the entire document in B&W and a part of the 
document in color to save storage space.  This is useful for 
documents where a photograph or signature appears in a 
consistent area on the document such as resumes, and so on.   
 
The following procedure describes how to reproduce the entire 
document in B&W and a portion of document (picture) in color.   
 
1. On the Paper tab, choose “Relative to Document” or “Fixed 

to Transport” from the Cropping option. 

2. Choose your scan size from the Scan Area option.  The 
selected scan size will be displayed in a red rectangular 
box.  This is also the scan size of your entire document. 
(For example, ISO B5.  If you have not chosen a scan area 
and leave the selection as None, then the default area will 
be the scanner’s maximum.)  

 

A red 
rectangular 
box 
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3. Click the Preview tab to display the Preview window.  A 

black rectangular box appears to indicate the max. scan 
size your have just selected. 

 
 
4. Click the Preview button to view the entire image in low 

resolution to correctly crop your relative scan area.  

 

5. Select image type from the Image Selection box.  The 
selected image will appear in highlighted color. (For 
example, Front Color) 

6. Place your cursor on the Preview window and click your 
left mouse button.  A cross sign will appear as illustrated.  
Create your relative scan size diagonally by dragging the 
left mouse button to your preferable size.  The selected 
area will appear in a red box as illustrated.  

A black 
rectangular 
box 

The Preview 
Image 

The Preview 
Button 

The Image 
Selection 

Box 
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7. Check the B&W image from the Image Selection box to 
scan the entire document. 

8. Click the Scan button to start scanning the document in 
two image types and sizes.  (See the result in below.)  

   
   The entire document in B&W     The relative area in color 

 

 
 

The 
Relative 
Area  

A Cross 
Sign 
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9.6.2 Other Paper Selection 

Carrier Sheet Mode: 
Check this option to automatically crop the scan window 
according to your document size when scanning non-standard 
document (fragile, irregular-size document) with a carrier sheet 
(optional). Note: The availability of this option varies due to 
scanner model. 
 
Loading Documents Using a Carrier Sheet 
 
A Carrier Sheet is a plastic sheet specifically used for loading 
non-standard document onto the scanner. It allows you to scan 
document that can not be scanned in the regular way. Also, 
documents larger than A4 size, such as A3 and B4, can be 
scanned by folding in half, inserting into the Carrier Sheet, and 
scanning in duplex mode. You can also scan documents that 
can be damaged quite easily such as photographs, or irregular 
size documents that are difficult to load directly such as 
clippings. 
 
To scan document using a Carrier Sheet,  
 
For documents larger than A4/Letter size, such as A3 

a. Fold the sheet to be scanned in half. 
b. Fold the sheet tightly and smooth out crease. Otherwise, 

the sheet may be skewed during scanning. 

 

1. Open the Carrier Sheet and place the document 
inside. 
Align the top of the document to the top of the Carrier 
Sheet (the printed area). 
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For documents larger than A4/letter size, such as 
A3 
Align the top of the document to the top of the Carrier 
Sheet (the printed section) and the folded portion to the 
right edge of the Carrier Sheet so that the document fits 
into the Carrier Sheet at the upper corner.  

 

For non-standard document 
Center your document in the Carrier Sheet. 

 
2. Load the Carrier Sheet with the gray section (printed 

section) facing downwards. 
 

3. Adjust the paper guides to the width of the Carrier Sheet. 
Adjust the paper guides so that there is no space 
between the guides and the Carrier sheet. Space between 
the guides and Carrier Sheet may cause the Carrier Sheet 
to become unaligned during scanning, and skew the 
scanned image. 

4.  Start the scan. 
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Notice: 
 [Carrier Sheet] is available for the models that support the 

Carrier Sheet. 
 Some functions are disabled when [Carrier Sheet] is 

checked. 
 This option may not work properly on some applications. 
 
 
Scan Area  

Choose your desired paper size with the drop-down list box.  Or 
you may select a custom paper size by clicking the Scan Area 
box and then click Add to include in the choice. 

Choices are listed below:  

None 

US Letter- 8.5”x 11” 

US Legal – 8.5” x 14” 

ISO A4 – 21 x 29.7 cm  

ISO A5 – 14.8 x 21 cm 

ISO A6 – 10.5 x 14.8cm 

ISO A7 – 7.4 x 10/5 cm 

ISO B5 – 17.6 x 25 cm 

ISO B6 – 12.5 x 17.6 cm 

ISO B7 – 8.8 x 12.5 cm 

JIS B5 – 18.2 x 25.7 cm 

JIS B6 – 12.8 x 18.2 cm 

JIS B7 – 9.1 x 12.8 cm 

Scanner Maximum 

Long Page (<118”) 
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Long Page (<118”):   
When you need to scan documents whose length exceeds 
scanner maximum, please choose Long Page.  Note if Long 
Page is selected, the Multi-Feed Detection will not be 
available. (Note: This option and the maximum allowable 
document length vary due to type of scanner.)   
 
When Long Page (<118”) is selected, be sure to specify your 
document size in the Length and Width field.  
 
Notice when scanning long page document: 

1. Pull out the extension in the ADF Paper Tray. 

2. Secure enough space around the Output Tray to prevent 
the ejected paper from falling off the Output Tray. 

3. To ensure the performance, in color mode, set the 
resolution to be 300 dpi or lower; in Black and White 
mode, set the resolution to be 600 dpi or lower. 

4. Depending on your system environments, application, or 
your specified paper size, there may be insufficient 
memory to perform scanning. 

OverScan 
Overscan allows you to add a specific margin at top and bottom 
or right and left (Options vary based on the type of scanner) of 
the edge of the image.  This is used to reduce possible corner 
clipping on the skewed images and often applied to a batch of 
skewed document to be scanned in the auto document feeder.  
Select a value between 0 and +5 mm.   Note the overscan 
result will not be shown in the Display window and that the 
availability of the function varies based on type of scanner.  
 
Pre-Feed 
Choice:  Enable, Disable.  If enable is selected, you can set the 
amount of time the scanner starts pre-feeding your paper after 
your documents has been loaded into the feeder. The default is 
disable. Note: The availability of this option varies due to 
scanner model. 
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Transport Timeout 
Set the amount of time the scanner will wait and then start 
auto scan after the first scan job is completed. If you have 
many separate documents need to be scanned at the same 
scan settings, this feature is especially useful. The default is 0.  
The value ranges from 0 to 30 seconds. 
 
 
Note:  
1 Within the specified timeout period, if you load your 

document to the feeder, the scanner starts scanning 
automatically. 

2 If your scanner has a flatbed option and you place your 
paper on the flatbed, after the timeout period, you need 
to click the Scan button on the TWAIN user interface to 
start scanning.  
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Background 
Setting 

This option allows you to set your scan 
background. Choice: White Background, 
Black Background. 

Note: For a sheet-fed scanner with an auto 
document feeder, this option is currently 
available only in the “Auto crop” mode. For a 
scanner with a flatbed platen, this option is 
available either in the “Auto crop” or the 
“Fixed to Transport” mode.  

 

 
White Background 

 

 
Black Background 
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9.7 The Multi-Feed Detection Tab 

Multi-Feed Detection    

Multi-Feed Detection allows you to detect overlapped document 
that go through the auto document feeder. Multi-Feed usually 
occurs due to stapled documents, adhesives on documents, or 
electro-statically charged document. Note： The availability of 
the function varies based on type of scanner. 
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Additional Length Detection 
Additional Length Detection allows you to define the length of 
document being multi-fed.  This value indicates the additional 
length exceeding your scan area.  The Display window will 
show the size of the document as you change the value.  A 
value of 0 indicates no additional length detection.  The 
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.   
 
Ultrasonic Detection 
 
Ultrasonic Detection  allows you to set overlapped document by 
detecting paper thickness between documents.  Note： The 
availability of the function varies based on type of scanner. 
 
 
There are two options available if Multi-Feed is detected.  

 Stop Scanning after Multi-Feed 

 If this is selected, the scanner will stop the feeder and 
prompt a multi-feed warning message. In addition, 
the multi-feed paper will be ejected from the scanner 
automatically.  

Note: The availability of the [Auto Clear Multi-Feed 
Paper] feature varies based on scanner type. If your 
scanner does not support this feature, remove the 
multi-feed paper manually. 

 
 If this is not selected, the scanner will continue 

scanning the entire document though multi-feed is 
detected. After the entire document has been scanned, 
a multi-feed dialog box will be prompted to indicate 
the page number which has been detected multi-feed 
and need to be rescanned. 
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 Multi-Feed Alarm  

If a wave file is added, the scanner will make a sound 
alarm if multi-feed is detected yet no Warning dialog box 
will be displayed.   

 

How to add the sound alarm： 

1.  Click the Browse button on the right side of the speaker 
icon. The Open dialog box appears.  

2.  Choose your wave file.  

3.  Click the Open button.  The wave file is added.  
 

Units 
Defines the primary measurement system.  Inches, 
Millimeters, and Pixels are available.  
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9.8   The Preview Tab 

The Preview tab allows you to preview (a low-resolution scan) 
your image before final scan.  This preview image lets you 
allocate your scan area.  You can choose your scan area by the 
“Scan Area” drop down list box or placing your cursor on the 
Display window and dragging it diagonally on the Display 
window.  Then, a red rectangle box will appear to indicate the 
selected area. 
 
Note:  If you choose “Automatic Cropping” on the “Paper Tab”, 
then to select a scan area on the Preview tab is not allowed. 
 

 
 

The Preview Tab 
 
 
 
 

The Display 
Window 
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9.9   The Enhancement Tab 

The Enhancement tab allows you to set following additional 
image processing settings.   
 

 

The Option tab dialog box 
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Punch 
Hole 
Removal 

You can remove punch holes from the output 
scanned image when scanning punched document. 
Note the availability of this feature varies 
depending on your scanner model. 

 

 

 

 

 

 

 

 

 

 

Punch holes can not be removed when: 

 Resolution is set lower than 150dpi 

 The hole is near the edge of the document 

 The holes are not aligned along the edge of the 
document 

 Punch Hole Removal is available only when 
“Auto Crop” is enabled. If either “Fixed to 
Transport”, “EOP (End of Page) Detection”, 
“Automatic Multiple”, “Relative to Documents” is 
selected from the Cropping option on the Paper 
tab, the Punch Hole Removal option will be 
disabled. 

 

 

Original Output image 
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Shadow Removal When 「Flatbed」on the 「Scan 

Source」 option is selected on the 
「Image」tab, the 「Shadow 
Removal」option will be enabled. Click 
to remove the shadow on the book spine 
when scanning a book.  

 

 

  

Before Shadow 
Removal 

After Shadow Removal 
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Background Processing:  The [Background Processing] 
option allows you to smooth background color or remove it to 
make image clearer. The option is especially useful for 
documents with color forms such as invoices.  
Choices: None (default), Smooth, Removal  
- None - no background processing will be performed 

(default) 
- Smooth - produces images with a more uniform 

background color. This option improves image quality. 
- Removal - identifies the background color and then 

removes it.   
 
Sensitivity:  Choice: 0, 1, 2, 3, 4.  Default: 0  
- The higher the value, the more background color will be 

kept.   
 
Mode: Auto, Moiré  
If [Smooth] is selected in the [Background Processing] 
option, then the choices for the [Mode] option includes Auto, 
and Moiré.  
- Auto - uses the factory preprogrammed mode to proceed 

background smoothing.  
- Moiré – Remove the moiré patterns that appear on the 

background of the image when scanning printed material. 
 
If [Removal] is selected in the [Background Processing] 
option, then the [Mode] option will be replaced with [Fill 
Color]. Choices: White, Auto.   
- White - identifies the background color and substitutes it 

with white. 
- Auto - identifies the background color and substitutes it 

with the color of the largest background zone.   
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Background Processing: None 
 
 
 

      
 

Background Processing: 
Smooth 

Background Processing: 
Removal 

 Fill Color: White 

 
         
Note:  Background color in small zone will not be processed or 
removed.  
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Edge 
Fill 

Check White or Black if you wish to add white or 
black edge on the border of your scanned image. 
Enter the value from 0 to 5 mm.  Default value is 0. 

 
Original 

 
Edge Fill: 5mm (Black) 
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Despeckle 
Occasionally small dots or specks appear in the background of 
a scanned image. Remove unwanted speckles provides a 
cleaner image for OCR (Optical Character Recognition) 
processing, and also helps to reduce compressed file size. 
 
Define the speckles (also known as image noise) you wish to 
remove by specifying its number (size) and radius (range). The 
measuring unit is pixel. The higher the number, the more 
speckles will be removed.  
 

 
Before Despeckle  
(noise number:0, noise radius:1) 

 
 

 
After Despeckle  
(noise number:22, noise radius:10) 

 
Note:  
 The function is currently available for Black and White 

image only. 
 To scan at rated speed, it is recommended to set the 

noise radius up to 10 pixels. 
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Line Removal: When Black and White image mode is 
selected on the [Image] tab, the [Line Removal] option will 
be enabled. Line Removal erases lines on the image and then 
reconstructs characters so the OCR (Optical Character 
Recognition) accuracy can be improved. 

Choices: None, Form, Horizontal, Vertical 

None – the default mode which does not remove any line. 

Form – remove any form in the document. 

Horizontal – select [Horizontal] and then enter the length of 
horizontal line to remove only the horizontal line exceeding 
your specified length. 

Vertical – select [Vertical] and then enter the length of 
vertical line to remove only the vertical line exceeding your 
specified length. 
 

  
None  Remove Form 

  
Remove Horizontal Line 

(over 30 mm) 

Remove Vertical Line 

(over 70 mm) 
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9.10 The Rotation Tab 

 
The Rotation tab allows you to set the following image rotating 
options:  
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Rotate 
Image 

Choose the rotation angle from the drop down 
list if you wish to rotate your scanned image. 

Choice: None, 90°CW(clockwise), 
90°CCW(counter clockwise), 180°, Auto 
based on contents. Auto rotate every 
even page. 

 

Original 
 

Rotate 90°CW 

 
Rotate 90°CCW 

 

Rotate 180° 

 

 Auto based on contents:  Automatically 
rotate images based on the contents of 
document. When「Auto based on 

contents」 is selected, its modes will be 
enabled to let you select more options. 

Mode: Quick, Full Text, Complexity 

Quick – the default mode to let you rotate 
images at the fastest speed. 

Full Text – the enhanced mode for 
documents with mixed text orientation. 

Complexity – the enhanced mode yet at the 
slowest speed for document with complex 
image or text orientation. 
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Auto rotate every even page: 

Automatically rotate 180° on every even 
page.  This is especially useful when you scan 
the inside pages from a book.  As a result, if 
you choose “Flatbed (book)” from the “Scan 
Source” option, “auto rotate every even page” 
will be selected as default.   

 

Note:  This option varies based on type of 
scanner. 

 

  
Document with various 
text orientations 

Document with dark or 
complex background 
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Split 
Image 

By splitting an image, two separate images are 
created horizontally or vertically. This is useful 
for documents containing two pages per image 
when you want to save them as two images 
(one page for one image). Choice: None, 
Horizontal, Vertical. Default is None. 

Horizontal: Divide one image into the upper 
half and the lower half.  

Vertical: Divide one image into the left half and 
the right half. 

 
 

Split Horizontally 

 
 

Split Vertical 
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Flip Side 
Rotation 

Select “fanfold” to rotate the image of the 
reverse side to 180 degrees.   

This is applied to double-sided document 
which are viewed in portrait are sometime 
fed into the scanner in landscape or vice 
versa.   

Choice: Book, Fanfold. 

If “Book” is selected, the image of the 
reverse side will not be rotated.  

 
The following illustration shows the documents which should 
be viewed in portrait are fed into the scanner in landscape 
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Image 
Control 
Option 

Check the Mirror box if you wish to reverse the right 
and left side of your image. 

 

 
Original 

 

 

 
The Mirror Effect 
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9.11 The Separation Tab 

The Separation tab allows you to enable the detection engine to 

detect the blank page, barcode, and patch code and then notify 

the software application which supports document separation to 

separate your multi-page documents. Choices: Blank Page 

Removal, Barcode Detection, Patch Code Detection. 

 
 
Blank Page 
Removal 

Choices: None, Blank Page Removal Threshold, 
Image Size. 

None – Do not remove the blank pages.  

Threshold - Move the slider to the left or right 
to define your threshold for the blank page. 

Image Size – Range: 1~ 10000 KB. Specify 
your desired image size to detect the page as a 
blank page. For example, if 3 KB is selected, 
any page less than 3 KB will be recognized as 
blank page.   
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When the bar code has been detected successfully，a file 
[avbarcode.ini] will be created and stored in the following path:  
 
Windows XP:  C:\Documents and Settings\All Users\Application 
Data\%PRODUCTNAME% 
 
Vista, Windows 7, Windows 8, Windows 10: 
C:\ProgramData\%PRODUCTNAME% 
 
Barcode Detection: 
Check [Enable] to detect barcode and notify the software 
application for advanced processing. Please note the whole 
document will be checked and no specific detection area needs 
to be designated.  

Barcode Types: 
The following barcode types can be detected.  
 
Two-dimensional codes 
 Aztec 
 DataMatrix 
 PDF417 
 QR Code 
 
One-dimensional barcodes: 
 Add-2 
 Add-5 
 Airline 2 of 5 
 Australian Post 4-State Code  
 BCD Matrix  
 Codabar  
 Code 128 (A,B,C) 
 Code 2 of 5 
 Code 32  
 Code 39  
 Code 39 Extended  
 Code 93  
 Code 93 Extended  
 DataLogic 2 of 5 
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 EAN 128 (GS1, UCC) 
 EAN-13 
 EAN-8    
 GS1 DataBar 
 Industrial 2 of 5  
 Intelligent Mail (One Code) 
 Interleaved 2 of 5  
 Inverted 2 of 5  
 ITF-14 / SCC-14 
 Matrix 2 of 5  
 Patch Codes  
 PostNet  
 Royal Mail (RM4SCC)   
 UCC 128 
 UPC-A  
 UPC-E  

 

Barcode Zone: 
Specify the barcode zone to be detected.   

Select 「All」 to checks the whole document and detects 
barcodes. Or you may speed up the process by specifying a 
detection area since only the specified area is checked. 

Choice: All, Top, Bottom, Left, Right, Bottom Right, 
Bottom Left, Top Right, Top Left  
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Choice for barcode zone on a page: 

 
 
 
 

 

 
 
 

 

All 

 
 
 
 

 

 
 
 

 

Top 

 
 
 
 

 

 
 
 

 

Bottom 

 
 
 
 

 

 
 
 

 

Left 

 
 
 
 

 

 
 
 

 

Right 
 
 
 
 

 

 
 
 

 

Bottom 
Right  

 
 
 
 

 

 
 
 

 

Bottom 
Left 

 
 
 
 

 

 
 
 

 

Top Right 
 

 
 
 
 

 

 
 
 

 

Top Left 

 
 

 
 
Note: 
 Recommended resolution: 200~600 dpi for regular 

barcode, 300~600 dpi for QR code  
 Skewed barcodes may not be recognized correctly. 
 Using the same sheet repeatedly may decrease the 

recognition accuracy due to accumulated dirt on the sheets. 
If the sheet is not recognized correctly or gets smudged, 
replace it with a new sheet. 
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Patch code Detection: 
Check [Enable] to detect patch codes and notify the software 
application for advanced processing. 

A patch code is a pattern of parallel, alternating black bars and 
spaces (i.e. a barcode) that is printed on a document. Patch 
code sheet is most commonly used as a document separator in 
a stack of document.  

You can find various sizes of patch codes (PDF) by choosing   
[Start] menu>[All Programs]>[Avision Scanner 
Series]>[Patch code] in succession.  

Simply print the PDF file to produce the patch code sheet. 
Insert the patch code sheets to wherever you want the file to 
separate. 

 

Notes to print the patch codes: 
 Use blank white paper. 

 Set the scaling to 100%. The sheet is not recognized 
correctly when printed in a size smaller than the original. 

 Do not use toner saving mode. The sheet is not recognized 
correctly when the print is too light. 

 Do not use thin paper in order to avoid bleed-through from 
the back. 

 When you copy a patch code sheet that you printed out, 
make sure to copy by the same size and brightness as the 
original copy. 

 Use the same sheet repeatedly may decrease the 
recognition accuracy due to accumulated dirt on the sheets. 
If the sheet is not recognized correctly or gets smudged, 
replace it with a new sheet. 

 

Patch code sheet 
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9.12 The Setting Tab  

The Setting tab allows you to set the following settings: 

 

The Setting tab dialog box 
 
Energy Saving 
Control 

Check the Enable Energy Saver box 
and move the slider to set the amount 
of time to start the energy saver after 
your last action. The range is from 1 to 
240 minutes.  The default value is 15 
minutes. 

Enable Power 
Off   

Check the Enable Power Off box and 
move the slider to set the amount of 
time to automatically turn off the 
scanner after your last action. The 
range is from 1 to 480 minutes.  The 
default is 240 minutes (4 hours). Note 
the value of “Power Off” has to be 
greater than or equal to the value of 
“Energy Saving”. 
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Cache 

 

Mode: None, Page Number, Memory 
Size.  

This option allows you to assign a specified 
memory size from the available RAM to 
process the image data. By specifying a 
smaller memory size, you can free more 
memory for other applications you are 
running. By specifying a larger memory 
size, you can have more memory to 
process the image data especially when you 
have a large amount of documents needed 
to be scanned.  

 

You can also specify your memory size by 
the page number. For your information, an 
A4 color document scanning at 300 dpi 
consumes approximates 24MB. 

Image Count 

When the selected cache mode is “none”, 
the image count option allows you to assign 
number of pages you need to scan. For 
example, if you wish to scan the first two 
pages, simply move the page slider to 2, 
and the scan action will be stopped when 
the scanning of the first two pages have 
been completed. 
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Show Scanning 
Progress 

Check and the scanning progress bar 
will be shown during scanning. 

Show Warning 
Message 

Check to show the warning messages 
such as “ADF pad count exceeds 
50,000 scans (the number varies based 
on type of scanner). Please replace the 
ADF pad and reset the pad count.” 

Save Settings 
after Closing 

Check to save your scanner properties 
settings after leaving the dialog box.  
Next time when you open the Scanner 
Properties dialog box, the previously 
saved settings will be shown. 
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9.13 The Imprinter Tab 

The Imprinter tab allows you to print alphanumeric characters, 
date, time, document count and custom message on your 
scanned image if digital imprinter is selected or at the back of 
your document if external imprinter is selected.  
 

 
 
 
Choice:  External Imprinter, Digital Imprinter. If you have 
installed an external imprinter, choose external imprinter. If 
you do not have an imprinter, choose digital imprinter. Note 
External Imprinter provides a vertical and rear-side print 
capability while digital printer provides a horizontal and front-
side print capability. 
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Contents 

Print All Check Print All to automatically print the 
text at all pages of your documents.  

Uncheck Print All to print the text for the 
first page of your documents only. 

Custom Enter your custom text to be included in your 
print string.  

Counter Show the document count for the scan 
session. This value is increased sequentially 
by the scanner.    

Date/Time Choose if you wish to include the date and 
time in your print string. 

Format: YYYYMMDDHHSS For example, 
20090402170645-check0001 indicates year, 
month, date, hour, seconds, your custom 
text and the counter. 

Custom 
Font 

Choose your desired font.  

Choice: Normal, Fixed Width 

Fixed Width (Mono spaced) fonts have a 
fixed character spacing. So each character 
occupies the same width. 

 

Advanced 

Font 
Attributes 

Choose your font attributes.  Choice:  
Normal, Underline, Double, and Bold. 
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String 
Orientation 

Choose your string orientation. 

Choice: Normal, Rotated, Vertical, 
Vertical Inversion, 90 degrees CW, 90 
degrees CCW 

 
Normal 

 
Rotated 

 
Vertical 

 
Vertical Inversion 

 
90 degrees CW 

 
90 degrees CCW 

 

If you check the digital imprinter to stamp 
text on your scanned image, the illustration of 
normal and rotated string is shown below: 

 
Normal 

 
Rotated 
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Print 
Position 

Choose the position you wish to print your 
string. Move the slider to the right to increase 
the value or to the left to decrease the value. 
Range: 0~355mm, default:0 mm 

The value indicates the height from the 
bottom of your paper to the last letter of your 
string. This option is available only if an 
external imprinter is installed. 

 

 

 

 

 

 

 

 

 

 

Print Position (for digital imprinter) 
Choose the position of your printed string. Choice: Top, 
Middle, Bottom, Custom. If Custom is selected, enter the X 
and Y offset value to specify the position. 
 
 

The value of 
Print Position 

0
0
0
1
ab

c 2
0
1
0
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9.14 The Information Tab  

The Information tab displays the following system and scanner 
information.  

 
 

The Information tab dialog box 
 

The “Report” button： 
If you encounter any error message while using the scanner, 
click the Report button.  A report.txt file [Windows XP:  
C:\Documents and Settings\All Users\Application 
Data\%PRODUCTNAME%; Vista, Windows 7, Windows 8, 
Windows 10: C:\ProgramData\%PRODUCTNAME% (C: system 
drive)] will be generated.  Please send this file to the nearest 
service center for trouble shooting.   
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The “Reset Roller Count” button： 

After scanning over a recommended number of pages (refer to 
subsequent section 7.4 Replacing the ADF Roller) through the 
ADF, the ADF roller may be worn out and you may experience 
problems with document feeding.  In this case, it is highly 
recommended to replace the ADF roller with a new one. (Note 
the replacement of the ADF roller has to be performed only by 
authorized service center.  Therefore, please return your 
scanner for roller replacement.)   After replacing the ADF roller, 
click the “Reset Roller Count” button to reset the roller count.   

 

Note： 
The lifetime and the replacing procedure vary based on type of 
scanner. 



User’s Manual 
 

 10-1 

10. Scanning and Sending 
the Scanned Images to 
Your Computer (BM2 Air) 

 

Before You Begin: 
Before you begin using the function of [BM2 Air], please make 
sure you have already installed the scanner driver, Button 
Manager V2, and connecting to the scanner to your computer via 
a USB cable as described in the preceding section, chapter 8 
Using the Product as a Regular Scanner. 

 

10.1 Installing Button Manager V2 

Button Manager V2 provides you an easy way to scan your 
document and then link the scanned image to your designated 
software application.  All this can be done by a simple touch of 
the button on the scanner. Yet, before you scan, it is 
recommended to check the button configurations first to ensure 
a proper file format and a destination application.   
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10.2 Checking the Button Configurations before Scanning  

1. Button Manager V2 runs from the system tray. After Button 
Manager V2 and the scanner driver are properly installed, 
Button Manager V2 is started and the Button icon will be 
displayed on the system tray at the bottom right corner of 
your computer screen. 

 
 

  
 
 
2. Left-click the Button Manager V2 icon to prompt the 

following Button Panel.  
 
 
 
 

 

The Button Panel 
 
 
 

This indicates the scanner model 

The Button 
Icon

The Function 
Icon 
(The number of 
function icons 
vary based on 
type of 
scanner.) 
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3. The Button Panel shows the first five scanning buttons.  

Right-click the button (function) you wish to check.  The 
Button Properties window appears. 

 
 
 

 
 
 

If you wish to change the setting, use this window to reset 
the setting for the file format, destination application, or 
other scan settings.     
 

4. Click the OK button to leave the window.  
 
 

Folder and 
file name 
for the 
scanned 
image 

Image Mode 
Selection 
Box 

Name of the Selected Button 

Scan To 
destination 
and settings 

Button 
Name 

OCR 
settings 

Basic Scan 
Parameters 
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10.3 Scanning From One Touch of the Buttons   

1. Adjust the paper guide for the width of paper and load the 
document with their tops into the automatic document feeder.   

2. Use ▼ to scroll down to [BM2 Air] on the LCD display. 
 
 
 
 
 
 
3. Check the button (function) number on the LCD screen to 

ensure if you are selecting the proper scan settings and 
destination application. (For example, if you wish to scan 
with button (function) 3, “Scan to App”, which opens 
Microsoft Paint and displays the scanned image in the 
window of Microsoft Paint, the LCD screen should show 
“Function 3”).  

4. Press the Scan button on the scanner. 
5. After the scanning is finished, the Microsoft Paint software 

will be launched and the scanned image appears in the main 
window of Microsoft Paint as below.  

 

 
 
Note: 
1. For details information on how to use the Button Manager 

V2, please refer to the user’s manual in the supplied CD. 
2. You may also use Button Manager V2 on your desktop by 

starting Button Manager V2 from All Programs or double 
clicking the Avision Scanner Utility from the Control Panel. 

 

E-mail Profiles 
Filing Profiles 
Scan to USB 
BM2 Air 

iScan (Image) 
PageCount () 
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11. Scanner Care 
 
 
 

11.1 Cleaning the ADF  

From time to time, the Reverse roller and the Feeding Rollers 
may be contaminated with ink, toner particles, or paper dust. 
In this case, the paper may not be fed smoothly. Please follow 
the following steps to clean the Reverse roller and the Feeding 
Rollers to ensure the best of the scanner. 

The Cleaning Steps: 

1. Soak a clean cloth with some isopropyl alcohol (95%). 
2. Press the ADF release button and open the front door. 
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3. Wipe the feeding rollers until they are cleaned. 
 

 
 

4. Press both sides of the cover of the ADF reverse roller and 
pull the cover down. 
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5. Press and wipe the rollers one by one. Rotate the roller until 
the surfaces are completely cleaned. 
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11.2 Cleaning the Glass  

1. Press the ADF release button.  Open the front door. 
2. Wet a clean cloth with some isopropyl alcohol. (95%) 
3. Wipe the glass as illustrated below by moving the swab from 

side to side to rid the dust or dirt. 
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11.3 Replacing the ADF Reverse Roller 

After scanning approximately 100,000 pages through the ADF, 
the reverse roller will be worn out and you may have problems 
with document feeding. It is time to replace the Reverse roller. 
For ordering the replacement, please contact your dealer. 
 
Disassembling Procedure 

1. Press the ADF release button. 
2. Gently open the ADF front door to the left.  
3. Hold the reverse roller cover with your fingers as shown and 

place it down. 
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4. Press the right end of the reverse roller externally to detach 

it from the slot and then detach the left end from its hole. 

 
 
Reassembling Procedure 

 
1. Insert the left end of the reverse roller to the hole of its 

original place. 
2. Insert the right end of the reverse roller to its slot. 
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3. Close the reverse roller Cover. 
 

 

 

4.   Close the ADF cover. 
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11.4 Replacing the ADF Rollers 

After scanning approximately 200,000 pages through the ADF, 
the ADF roller may be worn out and you may experience 
problems with document feeding.  In this case, you may need to 
replace a new ADF roller.  For ordering the ADF roller, please 
consult your nearest dealer and follow the procedure below to 
replace it.  

 
Disassembling Procedure 
 
1. Press the ADF release button to open the front door.  

2. Pull the center of the roller cover to open it.  
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3. Move the tab of the ADF roller DOWN as indicated. 
 

 
 

 
 

4. Detach the right end of the ADF roller from the slot and 
remove the ADF roller.  
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Assembling Procedure 

1. Insert the left end of the ADF roller first to its slot and place 
the ADF roller to its proper position.  

Make sure the belt in the center of the ADF roller is installed 
horizontally with the other rollers as indicated.  

 

2. Move the tab of the ADF roller UP. 

 

 

3. Close the ADF roller cover. A snap-in sound could be heard if 
correctly installed. 

The Belt 
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12. Troubleshooting 
 

 

 

12.1 Clearing a Paper Jam 

 
In the event of a paper jam, follow the procedures below to 
remove the paper: 

 
1. Press the ADF release button on the right side.  Gently 

open the front door. 

2. Carefully pull the paper out of the ADF unit. 

3. Close the front door.  Your Scanner is now ready to use. 
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12.2 Questions and Answers 

Question: Paper becomes jammed during 
scanning. 

Answer: 1) Open the front door. 

2) Pull out the jammed paper carefully. 

3) Close the front door. 

 
 

Question: More than one sheet of paper is 
fed into the scanner. 

Answer: 1) Open the scanner front door. 

2) Remove the multi-fed sheets. 

3) Close the front door. 

4) Flatten the corners and edges.  
Loosen the paper before putting it 
into the paper guide again. 

5) Check the feeding roller condition.  
If necessary, follow the cleaning 
directions in section 7.1 and 
perform the cleaning. 

 
 

Question: Paper becomes skewed in the 
scanner. 

Answer: 1) Use the slide guide to keep the 
paper path straight. 

2) Check the condition of the feeding 
roller.  If necessary, follow the 
cleaning directions in Section 7.1 
and perform the cleaning. 
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Question: Why does my scanned image 

always come out too dark? 

Answer: 1) Please adjust the screen settings to 
sRGB. 

2) Please adjust the brightness 
settings on the screen from 
application software. 

 
 

Question: When I choose optical resolution 
to be 600 dpi, the "auto crop" and 
"deskew" functions will be 
disabled. 

Answer: Since to perform auto crop and deskew 
consumes great deal of system 
memory, it is suggested if you wish to 
perform "auto crop" and "deskew" 
functions, please choose your optical 
resolution to be smaller than 600 dpi 
to prevent a error message. 
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12.3 Error Messages and Possible Solutions 

Error 
Code 

Message Solution 

59000 
59030 
59040 
59060 
59100 

Device internal failure 

Reboot the machine, and 
try again. If the error 
persists, contact service 
personnel. 

592301 Mail server is NULL 

1. Check “Mail server” 
setting. 
2. Contact your network 
administrator for further 
help 

530001 Device internal failure 

Reboot the machine, and 
try again. If the error 
persists, contact service 
personnel. 

530002 
Fail to connect Mail 
server 

Contact your network 
administrator for further 
help. 

531001 
SMTP login name error 
or SMTP login password 
error 

Check if the login name and 
password are correct. 

530421 
531421 
532421 
533421 
534421 
536421 

SMTP [421] Service not 
available, closing 
transmission channel. 
The Server is going to 
shut down. 

Contact your network 
administrator for further 
help. 

530440 
SMTP[440] mail from 
account doesn't conform 
with authentication 

The account of from and 
login must be same. 
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532450 
533450 

SMTP [450]Requested 
mail action not taken: 
mailbox unavailable 

Contact your network 
administrator for further 
help. 

532451 
533451 
534451 
535451 
537451 

SMTP [451]Requested 
action aborted: local 
error in processing 

Contact your network 
administrator for further 
help. 

533452 
535452 
537452 

SMTP [452]Requested 
action not taken: 
insufficient system 
storage 

Contact your network 
administrator for further 
help. 

531501 
532501 
533501 
534501 

SMTP [501]Syntax error 
in parameters or 
arguments 

1. Check “From” address. 
2. Check “To” address. 
3. Contact your network 
administrator for further 
help. 

531504 
SMTP [504]Command 
parameters not 
implemented 

1. Check “From” address. 
2. Check “To” address. 
3. Contact your network 
administrator for further 
help. 

533550 

SMTP [550]Requested 
action not taken: 
mailbox unavailable[E.g., 
mailbox not found, no 
access] 

Check “To” address. 

533551 
SMTP [551] User not 
local: please try again. 

1.Check “To” address.  
2. “From” address and 
“To” addresses must be 
different. 
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533552 
535552 
537552 

SMTP [552]Requested 
mail action aborted: 
exceeded storage 
allocation 

1. Check “To” address. 
2. Check mailbox storage 
allocation. 
3. Contact your network 
administrator for further 
help. 

533553 

SMTP [553]Requested 
action not taken: 
mailbox name not 
allowed 

Check “To” address. 

534554 
535554 
537554 

SMTP [554]Transaction 
failed 

Contact your Network 
administrator for further 
help. 

538001 
Connection broken 
during data transmission. 

1. Check network 
environment. 
2. Check if the disk space 
of your email attachment 
is larger than the mailbox 
quota. 

540001 
540009 
540010 
540011 
540012 
540013 
540014 
543501 
545501 
545504 

Device internal failure 

Reboot the machine, and 
try later. If the error 
persists, contact service 
personnel. 

540002 
540003 

Fail to connect FTP 
server. 

Make sure the FTP server 
has not been shut down 
and the port number is 
correct. If the error 
persists, contact your 
network administrator. 
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540004 FTP login name error 
Check your login name 
and try again. 

540005 FTP password incorrect 
Check your password and 
try again. 

540006 retry 3 times for path 

The FTP's path has some 
problems. Contact your 
network administrator for 
further help. 

540007 
timeout or Job name is 
NULL 

Input file name within 
limited duration.   

540008 can't get data socket 
Check network 
environment. 

540015 
Connection broken 
during data transmission. 

Check network 
environment. 

540016 file exist, rename fail Re-input new file name. 

541001 
542001 
543001 
544001 
545001 
546001 
547001 
548001 

command exceeds 
maximum size of 256 

Reboot the machine, and 
try later. If the error 
persists, contact service 
personnel. 

541002 
542002 
543002 
544002 
545002 
546002 
547002 
548002 

The command transfer 
fails 

Check network 
environment. 
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541003 
542003 
543003 
544003 
545003 
546003 
547003 
548003 

The command reply read 
fails. 

Check network 
environment. 

541004 
548004 
542004 
543004 
544004 
545004 
546004 
547004 

The FTP server doesn't 
reply message. 

Contact your network 
administrator. 

546005 file transfer fails 
Check network 
environment. 

541421 
542421 
543421 
544421 
545421 
546421 
548421 

[421] Service not 
available, closing control 
connection.   

Too many connections 
from this IP, contact your 
network administrator. 

544450 
546450 
548450 

Requested file action not 
taken. 

The file already exists and 
is locked by Windows. 

546452 
548452 

Requested action not 
taken. Insufficient 
storage space in system. 

Ask FTP administrator to 
increase allotted storage 
space, or delete 
unnecessary files. 
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541500 
542500 
543500 
544500 
545500 
546500 
547500 

[500]Codes The 
command was not 
accepted and the 
requested action 
did not take place. 

Contact your network 
administrator. 

541501 
542501 
544501 
546501 

[501]Syntax error 
in parameters or 
arguments. 

Check your input parameters; 
e.g., make sure there is no 
wrong characters, spaces, etc. 

541502 
542502 
544502 

[502]Command 
not implemented. 

The server does not support this 
command. Contact your 
network administrator. 

541550 
542550 
546550 

[550]Requested 
action not taken. 
File unavailable 
(e.g., file not 
found, no access). 

Verify that you are attempting 
to connect to the correct 
server/location. The 
administrator of the remote 
server must provide you with 
permission to connect via FTP. 

546553 
48553 

Requested action 
not taken. File 
name not allowed. 

Change the file name or delete 
spaces/special characters in the 
file name. 

561032 
Error share folder 
name  

Please check if the shared folder 
name is correct. 

561003 Error share path 
Please check if URL or IP 
address is correct. 

561012 

Error account 
name or password  
or the date of 
machine is 
incorrect. 

1. Check if account name or 
password is correct. 
2. Check if current local time on 
the machine is correct.  

561019 
No authority to 
create directory 

Check account authority on the 
shared folder.  
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564019 
No authority to 
write file 

Please check account authority 
on share folder.  

561183 
Duplicate 
directory name 

Rename a new directory name. 

564183 
Duplicate file 
name 

Rename a new file name. 

561034 File in use Please close the file in use. 

563021 
CIFS service is 
not ready 

1. Please wait CIFS service 
initialization, and try scan-to 
CIFS again later. 
2. Please check the same host 
name on different machine. 

563039 Disk is full Please clean up disk space. 

562088 Time out 
Server busy. Try scan-to CIFS 
again later. 

002013 
003205 
003206 
003207 

Paper jam. Open the front door to remove 
the jammed paper. 

003101 Multiple feed. Remove paper. 
Fan your paper and try again. 

002014 ADF cover 
opens. 

Close ADF cover. 
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003005 ADF Bottom 
Head Light check 
error. 

Restart the device. If the error 
persists, call service to replace 
the lamp. 

003006 ADF top head 
light check error. 

Restart the device. If the error 
persists, call service to replace 
the lamp. 

003003 DRAM read and 
write test error. 

Restart the device. If the error 
persists, call service to replace 
the main board. 

003004 ADF DRAM read 
and write test 
error. 

Restart the device. If the error 
persists, call service to replace 
the main board. 

002024 NVRAM read and 
write test error. 

Restart the device. If the error 
persists, call service to replace 
the main board. 

002037 ADF Bottom 
head AFE test 
error. 

Restart the device. If the error 
persists, call service to replace 
the main board. 

000016 UART read and 
write test error 

Restart the device. If the error 
persists, call service to replace 
the main board. 

000017 Motor Stall Restart the device. If the error 
persists, call service to replace 
the motor. 

000020 Download 
firmware error 

Check firmware file and try 
again. 

000022  Lamp off error. Restart the device. If the error 
persists, call service to replace 
the lamp. 

000023 Flashrom read 
and write test 
error. 

Restart the device. If the error 
persists, call service to replace 
the main board. 
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000024 ADF bottom head 
AFE LVDS test 
error. 

Restart the device. If the error 
persists, call service to replace 
the main board. 

000025 ADF top head 
AFE LVDS test 
error. 

Restart the device. If the error 
persists, call service to replace 
the main board. 

002033 Page skew. Remove paper. 

Fan your paper and try again. 

000029 ADF AFE read 
and write test 
error. 

Restart the device. If the error 
persists, call service to replace 
the main board. 

003211 Page miss-feed. Make sure the edge of your 
document slightly touch the 
paper guides and try again. 

002015 ADF no paper. Load paper into the auto 
document feeder. 
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12.4 Accessing the Menu Settings and Service Mode 

 
The machine provides the option of menu settings and service 
mode on the LCD screen for easy troubleshooting or serving 
purpose.  Save your log report and then send to service 
personnel for a quick troubleshooting solution. 
 
To access the menu settings and service mode, follow these 
steps: 
 
1. Scroll down to [Menu Settings] on the LCD screen and 

press  to select. 
 
 
 
 
 
 
2. Select [Service Mode] and press  to select. 
 
 
 
 
 
 
3. Select [Log Setting] and select your Log class and level. 

Choice of Class: System, Network, Scan.  
Choice of Level: Level 1, Level 2, Level 3.  
Save to USB: Save the log file to a removable USB drive. 
Save at Poweroff: On/Off.   

 
 
 
 
 
 
 

Scan to USB 
Scan to PC 
AP Mode 
Menu Settings  

FW Upload (USB) 
Log Settings 
Run-in Test 
Debug Info 

Network Settings 
Auto Power Off 
Service Mode 

Set Log Class 
Set Log Level 
Save to USB 
Save at Poweroff 
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4. Plug an USB flash drive into the USB flash drive port and 

then select [Service Mode]>[Log Settings]>[Save to 
USB] to save the log file to removable USB drive.    

 
Or you may turn [On] on the [Save at Poweroff] option. 
The log file will be automatically saved to your USB flash 
drive whenever the system is turned down and restarted.    

 
5. Choose [Debug Info] to record the firmware version. 
 
6. You may send the firmware version and log file to the 

service personnel for a quick troubleshooting solution. 
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12.5 Technical Service  

 
Before contacting Avision, please prepare the following 
information by referring to Section 4.14, The Information Tab: 

 
 Scanner serial & revision number (located on the bottom of 

the scanner); 
 Hardware configuration (e.g., your host CPU type, RAM size, 

free disk space, display card, interface card); 
 The name and version of your scanning software application;  
 The version of your scanner driver.  

 
Please call us at: 

 
Headquarter 
Avision Inc. 
No. 20, Creation Road I, Science-Based Industrial Park,  
Hsinchu 300, Taiwan, ROC 
TEL: +886 (3) 578-2388 
FAX: +886 (3) 577-7017 
E-MAIL:  service@avision.com.tw 
Web Site: http://www.avision.com.tw 
 
US and Canada Area  
Avision Labs, Inc. 
6815 Mowry Ave., Newark CA 94560, USA 
TEL: +1 (510) 739-2369 
FAX: +1 (510) 739-6060 
E-MAIL:  support@avision-labs.com 
Web Site:  http://www.avision.com 
  
 
 
 
 
 
 

mailto:service@avision.com.tw�
mailto:support@avision-labs.com�
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China Area  
Hongcai Technology Limited 
7A,No.1010, Kaixuan Road, Shanghai 200052 P.R.C.  
TEL :+86-21-62816680 
FAX :+86-21-62818856 
E-MAIL : sales@avision.net.cn 
Web Site:http://www.avision.com.cn 

 
Europe Area  
Avision Europe GmbH  
Bischofstr. 101 D-47809 Krefeld Germany  
TEL: +49-2151-56981-40 
FAX: +49-2151-56981-42 
E-MAIL:  info@avision-europe.com 
Web Site:  http://www.avision.de 
 
Espaço Brasil  
Avision Brasil Ltda. 
Avenida Jabaquara, 2958 - Cj. 75 - Mirandópolis –  
CEP: 04046-500 - São Paulo, Brasil 
TEL: +55-11-2925-5025 
E-MAIL: suporte@avisionbrasil.com.br 
Web Site: http://www.avisionbrasil.com.br 
 

 
 
 

 

http://www.avision.com.cn/�
http://www.avision.de/�
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13. Product Specifications 
 
 
 
All specifications are subject to change without notice. For 
the most up-to-date and detailed specifications, please refer to 
our web site at http://www.avision.com 
 
Model Number：  FL-1401B (Duplex Scanner) 
Optical Resolution:  600 dpi 
Scanning Modes:  Black & White  

Gray  
Color  

ADF Capacity:   Up to 80 pages (70 g/m2) (20 lb.) 
Max. Document Size:  216 x 356 mm (8.5 x 14 in.) 
Min. Document Size:  50 x 50 mm (2 x 2 in.)   
Paper Weight:   27 ~ 413 g/m2  (7 ~ 110 lb.) 
ID Card Thickness:  <1.25 mm (0.05 in.) 
Connectivity:   Hi-speed USB 2.0,  

RJ-45 Ethernet 10/100/1000 Mb, 
Wi-Fi 

Power Source:   24V, 2.0A  
Operating Temperature: 10ºC~35ºC 
Dimensions: (WxDxH)  

Open ADF   316 x 680 x 239 mm   
(12.4 x 26.8 x 9.4 in.) 

Close ADF  316 x 191 x 168 mm 
(12.44 x 7.52 x 6.61 in.) 

Weight:   4.1 kg (9.04 lb.) 
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Wi-Fi Specifications: 

 

 Model: GWF-7A05 

 

Main Chipset MT 7601U 

Host interface USB 2.0  

LED Link/Activity 

Antennas Built-in onboard PCB antenna 

Frequency 
Range 

ISM band, 2412~2483.5MHz (depends 
on country region) 

Transmit 
Power(EIRP) 

802.11b (CCK) 11Mbps: 18+/-1dBm   

802.11g (OFDM) 54Mbps: 15+/-1dBm  

802.11n (HT20@MCS7) 14+/-1 dBm, 
(HT40@MCS15) 14+/-1 dBm 

Receive 
Sensitivity 

802.11b: -88+/-1dBm; 802.11g: -73+/-
1dBm 

802.11n (HT20), -71+/-1dBm; 802.11n 
(HT40), -68+/-1dBm 

Operating 
System 

Windows XP/Vista/7; Linux 2.6.X 

Security 
WEP 64/128, WPS; WPA/WPA2 
(TKIP,AES); WAPI 

Voltage 
Range/Current 

DC 5.0V +/-5% /<150mA @802.11g 
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